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サード・パーティ・ソフトウェア。ユーザーは、Dellのサプライヤの許可を得て取得した付

属マニュアルなどの印刷物や電子媒体(「サード・パーティ・ソフトウェア」) に示すとお

り、ソフトウェア製品にDellのサプライヤの著作物であるソフトウェアを含んでいたり、備

えている場合があることを認めるものとします。 かかるサード・パーティ・ソフトウェアを

使用する場合は、ソフトウェア製品のインストール・ディレクトリにある「サード・パーティ・

ライセンスReadMe」ファイルかそれに類するファイルに記載のマニュアルまたは媒体に

定める適用される制限事項などの条件に従うものとします。

オープン・ソース・ソフトウェアはいずれも利便性を期待して配布されますが、現状のま

ま提供され、明示または黙示を問わず、いかなる保証もいたしません。この保証には、

商品適格性や特定目的への適合性の黙示的保証を含みますが、これらに限定される

ものではありません。事由の如何を問わず、損害発生原因の如何を問わず、かつ、責

任の根拠が契約であるか厳格責任であるか(過失その他) 不法行為であるかを問わ

ず、Dell、著作権保持者、協賛者は、損害が生じる可能性について報告を受けていたと

しても、本ソフトウェアの使用から生じた直接的、間接的、偶発的、特別的、懲罰的ま

たは結果的損害のいずれに対しても一切責任を負いません(代替品またはサービス

の提供、使用機会、データまたは利益の損失の補償、または、業務の中断に対する補

償を含む)。
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製品概要

Dell™ Remote Console Switch( RCS) ソフトウェアは、異なるプラットフォーム間で

作動する管理アプリケーションで、スイッチおよび接続されているすべてのサー

バーの表示および制御を行うことができます。異なるプラットフォーム間で作動す

る設計により、広く使用されているほとんどのオペレーティング・システムとハード

ウェアのプラットフォームとの互換性が確実になります。 RCSソフトウェアでは、ス

イッチ・ベース認証、データ転送およびユーザー名／パスワードの保管が安全に

実施できます。 各スイッチで認証とアクセス・コントロールが個別に取り扱われ、

システム制御の分散が効果的に行われます。

RCSソフトウェアでは、直観的な分割画面インターフェイス形式のExplorer型ナビ

ゲーション方式が使用されており、システム全体に対して単一ポイントからアクセ

スできる操作性が追加されています。 ユーザーはここから、システム・サーバー

に対して、既存のスイッチの管理、新規スイッチのインストール、ビデオ・セッション

の起動などを行うことができます。 またサーバー、サイト、フォルダ別などの組み

込みのグループ分けにより、表示するユニットの選択が容易にできます。強力な

検索・分類機能により、いずれのユニットの検索も簡素化します。

特長とメリット
RCSソフトウェアは、簡単にインストールと操作ができるよう設計されています。

管理下にあるスイッチを自動検出する機能により、新しいユニットを数分でインス

トールすることができます。 ウィザードベースのインストールとオンラインのヘル

プにより、システムの初期設定が簡単に実施できるようになっています。 直感的

なグラフィックを利用したインターフェイスの導入により、スイッチの管理と更新は

非常に簡単で分かりやすくなっています。
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強力なカスタマイズ機能

RCSソフトウェアを調整して、システムの特定のニーズに合わせることができま

す。デフォルトのグループを活用することも、またユーザー独自のグループを作

成することもできます。ユニットやフィールドの名前、およびアイコンをカスタマイ

ズして、ユーザーがより使いやすいように設定を変更できます。 例えば、システ

ム・ユニットは、ユーザーが識別しやすい名称を使用すれば短時間で容易に検索

できます。

Remote Console Switchの広範囲な管理機能

RCSソフトウェアを使用すると、一つのシステム内に複数のスイッチを追加し、管

理することができるようになります。 新しいスイッチをインストールすると、スイッ

チ・パラメーターの構成、ユーザー・ビデオ・セッションの制御、プリエンプトができ

るようになります。さらにスイッチの再起動やアップグレードなどのコントロール機

能も実行できます。 RCSソフトウェアは、Dell OpenManager™ IT Assistant Event

Viewerに対応するように設計されているので、システム管理者はシステム・イベン

トの各レポートを統合することができます。 簡易ネットワーク管理プロトコ

ル( SNMP) トラップの有効化、ターゲット・デバイスの構成、ユーザー・データベー

スの管理が実行できます。

このソフトウェアを使用して、以下のDellスイッチを管理することができます。

• 4322DS

• 2162DS

• 1082DS

• 2161DS

• 2321DS

• 4161DS

• 2161DS-2

• 1081AD

• 2161AD
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注: Dell 1081ADと2161ADスイッチについては、 RCSを介して追加／管理するスイッ
チ用にDellリモートアクセスキー( RAK)が必要です。

認証および承認

RCSソフトウェアを使用すると、複数のRemote Console Switchのアクセス権を、

それぞれのRemote Console Switchで個別に管理するのではなく、単一のイン

ターフェイスで管理できます。 セキュリテ ィと効率性を向上させるため

に、Lightweight Directory Access Protocol( LDAP) 機能ではネットワーク全体の

単一認証ソースからアクセス権を取得するため、個々のRemote Console Switch

でアクセス権を更新する必要がありません。

Remote Console Switch では、標準のActive DirectoryスキーマまたはDell

Extended Schemaを使用して認証を行い、すべてのDellハードウェアとの互換性を

最大限に保つことができます。

注: Dell 1081ADおよび2161ADスイッチはLDAPをサポートしません。

システム・コンポーネント
本ソフトウェアの主要コンポーネントは、以下のとおりです。

RCS Explorerウィンドウ

RCS Explorerウィンドウは、ソフトウェア機能にアクセスする際の主要な制御を行

うウィンドウです。ローカル・データベースで定義されているスイッチやターゲット・

デバイスは、Explorerウィンドウから参照できます。 ユニットの一覧は、既定の分

類カテゴリー( アプライアンス、デバイスなど)により異なる方法で表示できます。

また新たな名称でフォルダを追加することによりカテゴリーをカスタマイズすること

もできます。ユニットにカスタム・フィールドを指定して他のカテゴリーを使用する

こともできます。

Explorerのデバイス・リストでは、ターゲット・デバイス・リストからデバイスを選ん

で、このデバイスとのKVMセッションを起動することができます。キーボード／ビ

デオ／マウス( KVM) セッションを起動すると、ビデオ・ビューアが開きます。

Explorerのアプライアンス・リストでは、構成したいスイッチを選択できます。



10xxx |製品概要xxx

ビデオ・ビューア

ユーザーはこのビデオ・ビューアからターゲット・デバイスへのアクセスや管理を

行います。事前に定義されたマクロの中から、ビデオ・ビューアのマクロ・メニュー

に表示するマクロ・グループを選択できます。 Remote Console Switchでは、ビデ

オ・ビューアを開いてターゲット・デバイスに接続できます。詳細については、「ビ

ューアの使用法」( ページ63) を参照してください。

また、ビデオ・ビューアからはバーチャル・メディア・ウィンドウにもアクセスできま

す。 バーチャル・メ ディア・ ウィン ドウでは、物理ドライブ( ディスク、CD-

ROM、DVD-ROMのデータ・ドライブなど) をターゲット・デバイスにマッピングでき

ます。これによって、メディア・デバイスが直接ターゲット・デバイスに接続されて

いない場合でもデバイスを使用できるようになります。バーチャル・メディア・ウィ

ンドウに関する詳細については、「ビューアの使用法」( ページ63) を参照してくだ

さい。

Avocent®製品との相互運用性

RCSソフトウェアを使用して一部のアボセント製スイッチにアクセスできます。 ま

た、これらのアボセント製スイッチを管理できるので、システムの管理での柔軟性

を高めることもできます。

さらに、RCSソフトウェアはAvocent IQモジュールもサポートしているため、より多

くのサーバー・タイプをアクセス、管理できます。 Avocent IQモジュールのサポート

が追加されたことにより、次の接続がサポートされるようになりました。

• PS/2モジュール( Dell/Avocentモジュール経由)

• バーチャル・ メ デ ィ アおよ びスマー ト・ カー ド／Common Access

Card( CAC) バージョンなどのUSBモジュール( Dell／Avocentモジュール

経由)

• VT100シリアル・モジュール( Avocentモジュール経由)

• Trueシリアル・モジュール( Dell／Avocentモジュール経由)

• Sunモジュール( Avocentモジュール経由)

• PS2Mモジュール( Avocentモジュール経由)
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注: Dell SIPモジュールは、直接接続されているアボセント製スイッチでサポートされ
ています。

注: Dell 1081ADおよび2161ADスイッチはTrueシリアル・モジュールをサポートしませ
ん。

操作機能
RCSソフトウェア機能には、ターゲット・デバイスの名前付け、ターゲット・デバイス

名の表示、並び替え、およびIPv4とIPv6ネットワーク・アドレス機能が含まれま

す。「キーボードとマウス」( ページ109) にExplorerの操作で使用するショートカッ

トが一覧されています。他のコンポーネントも、マウス操作に加えてキーボードの

フル操作に対応しています。

ターゲット・デバイスの名前付け

このソフトウェアでは、各スイッチとターゲット・デバイスで固有の名前が必要とな

っています。データベース内の既存の名前と競合する名称に対しては、ソフトウェ

アは次の手順で固有の名前を生成し、ユーザーの介入を最小限に抑えます。

バックグラウンド処理(名前や接続の追加・変更などの自動処理)中に競合する名

前が検出された場合、競合する名称は自動的に固有名に変更されます。これは、

ティルデ (~) の後に任意の数字を加えることで行われます。数字は、ティルデを追

加しただけでは名前を固有化できない場合に追加されます。 この場合、数字は1

の値から始まり、名前が固有のものになるまで増分されます。

操作中に固有ではない名前を指定すると、固有名を指定するよう求めるメッセー

ジが該当のユーザーに表示されます。

ターゲット・デバイス名の表示

スイッチが追加されると、このスイッチから取得したターゲット・デバイス名はソフト

ウェアのデータベースに保存されます。 この後、ユーザーはExplorerでターゲッ

ト・デバイス名を変更できます。 新しい名はデータベースに保存され、様々なコン

ポーネント画面で使用されます。 ターゲット・デバイスの新しい名は、スイッチには

送信されません。

このソフトウェアは分散処理型の管理システムとなっているため、スイッチ上の

ターゲット・デバイスに割り当てられた名前は、ソフトウェアのデータベースを更新
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する必要なしにいつでも変更できます。管理下のターゲット・デバイスのリストは、

ユーザーごとにカスタマイズして表示することができます。

単一のターゲット・デバイスに対して複数の名前を関連付けるため(スイッチ上で

はある名称、ソフトウェア内で別の名称、のように) 、ソフトウェアでは以下の規則

に従ってどの名前を用いるかが判断されます。

• Explorerは、自己のデータベース内のターゲット・デバイスのみを、この

データベース内にある名前で一覧表示します。 すなわち、ターゲット・デ

バイスの情報を得るためにExplorerがスイッチにクエリを送ることはあり

ません。

• 再同期化ウィザードは、スイッチのターゲット・デバイス名がデフォルト名

から変更された場合にのみ、ローカルで指定したターゲット・デバイス名

を上書きします。 再同期化中にスイッチから読み込まれたターゲット・デ

バイスの非デフォルト名は、ローカルで指定した名前に優先します。

分類機能

ソフトウェア・コンポーネントの一部の表示形態では、各アイテムに関する情報が

複数のコラムに示されるアイテムのリストが表示されます。 コラム・ヘッダーに矢

印がついている場合、このリストを表示する際は、コラムを昇順または降順に分類

して表示できます。

コラム・ヘッダーごとに表示を分類するには、コラム・ヘッダーの矢印をクリックし

ます。 リスト内のアイテムはこのコラムに従って分類されます。上向き矢印は、リ

ストがこのコラム・ヘッダーで昇順に配列されていることを示します。下向き矢印

は、リストがこのコラム・ヘッダーで降順に配列されていることを示します。

IPv4およびIPv6のネットワーク･アドレス機能

RCSソフトウェアは、現在サポートされているインターネット･プロトコル･バージョ

ンであるIPv4( デフォルト) またはIPv6のいずれか、またはIPv4モードとIPv6モード

の両方を同時に使用するシステムにも対応しています。

注: Dell 1081ADおよび2161ADスイッチは、IPv4とIPv6モードの同時使用には対応し
ていません。

IPv4モードの接続は、ステートフル( 設定とIPアドレスをサーバーから取得する) あ

るいはステートレス(スイッチは通常、IPアドレスとルーター･アドレスをルーターか
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ら動的に取得する)の自動設定のいずれかです。 IPv4モードの場合、スイッチのフ

ァームウェア・アップグレードと緊急起動ファームウェア・アップグレードは、TFTP

サーバーとFTPサーバーの両方でサポートされます。

IPv6モードはステートレスの自動設定接続です。 IPv6モードの場合、スイッチのフ

ァームウェア・アップグレードはFTPモードのみで対応しており、緊急起動ファーム

ウェアのフラッシュ・ダウンロードは実行できません。フラッシュ・ダウンロードを行

うには、TFTPサーバーを介して一時的にIPv4ネットワークに接続する必要があり

ます。

注: Dell 1081ADおよび2161ADスイッチでは、IPv6モードはステートフル接続です。
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インストール

RCSソフトウェアをクライアント・コンピューターにインストールする前に、必要なア

イテムがすべて揃っていること、およびターゲット・デバイスとRCSクライアント・コ

ンピューターで作動しているオペレーティング・システム、ブラウザ、Java Runtime

Environmentがサポート対象のものであることを確認してください。

ソフトウェアに同梱されているアイテム
このソフトウェアは、アプライアンスのRemote Console SwitchソフトウェアCDに

収録されています。 ユーザー用のマニュアルは、Remote Consoleソフトウェア

のExplorerウィンドウのヘルプ・メニューから、オプションとしてアクセスできます。

サポートされているオペレーティング・システム
RCSを稼動しているクライアント・コンピューターでは、次のいずれかのオペレーテ

ィング・システム・バージョンを使用している必要があります。

• Microsoft® Windows® 2003 Server、Service Pack 3 Web、Standard、お

よびEnterprise

• Microsoft Windows Server® 2008 Web、Standard、およびEnterprise

• Microsoft Windows XP Professional( Service Pack 3)

• Microsoft Windows Vista™ Business( Service Pack 1)

• Microsoft Windows 2000 Professional、Service Pack 4

• Microsoft Windows 7 Home PremiumおよびProfessional

• Red Hat® Enterprise Linux® 4.0および5.0 WS、ES、およびAS

• SUSE® Linux Enterprise Server 10、およびServer 11
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• Ubuntu 8 ServerおよびWorkstation

ターゲット・デバイスでは次のいずれかのオペレーティング・システムを稼動してい

る必要があります。

• Microsoft Windows 2000 Server( 32-bit) およびAdvanced Server

• Microsoft Windows XP ProfessionalおよびStandard( Service Pack 3)

• Microsoft Windows Server 2003 Web、Standard、およびEnterprise

• Microsoft Windows Server 2008 Web、Standard、およびEnterprise

• Microsoft Windows Vista Standard、Business( Service Pack 1) 、およ

びEnterprise

• Microsoft Windows 7 Home PremiumおよびProfessional

• Netware 6.5( 32ビット)

• Red Hat Enterprise Linux 4.0および5.0( WS、ES、およびAS)

• Solaris Sparc 10( 64ビット)

• SUSE Linux Enterprise Server 10およびServer 11

• Ubuntu 8 ServerおよびWorkstation

• VMWare® ESX 3およびESX 4( 32-bit)

ハードウェア構成の要件
本ソフトウェアのシステム・ハードウェア構成の最小要件は以下のとおりです：

• 500 MHz Intel® Pentium® III

• RAM 256 MB以上

• 10または100BaseT NIC( 100推奨)

• グラフィック・アクセラレーター付きXGAVideo

• デスクトップ解像度が少なくとも800 x 600であること

• カラーパレットが少なくとも65,536色( 16ビット) であること
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サポートされているブラウザ
Webインターフェイスへのアクセスに使用するコンピューター、およびこのソフトウ

ェアを実行するクライアント・コンピューターには、次のいずれかのブラウザがイン

ストールされている必要があります。

• Microsoft Internet Explorer バージョン 6.x SP1以降

• Firefoxバージョン2.0以降

JREの要件
このソフトウェアを実行しているクライアント・コンピューターを使用してターゲット・

デバイスにアクセスするコンピューターには、Java Runtime Environment (JRE)

の1.6.0_11以降のバージョンがインストールされている必要があります。 スイッチ

は、該当のコンピューターにJavaがインストールされているかどうかの検出を試み

ます。 Javaがインストールされていない場合には、http://www.java.comからダウ

ンロードし、JNLPファイルをJava WebStartと関連付けてください。

ソフトウェアのインストール
このソフトウェアは、Microsoft WindowsおよびLinuxのオペレーティング・システム

にインストールできます。 対象システムにRCSソフトウェアをインストールするに

は、次の手順に従います。

Microsoft Windowsシステムにインストールするには：

1 CD-ROMドライブにRCSソフトウェアのCD-ROMを挿入します。

2 デフォルト・ドライブをCD-ROMドライブの文字に設定し( 「drive」をCD-ROMド

ライブ文字に置き換える) 、次のコマンドを実行すると、インストール・プログラ

ムを起動できます。

drive:\WIN32\SETUP.EXE.

3 画面上の手順に従ってください。

Linuxシステムにインストールするには：

1 CD-ROMドライブにRCSソフトウェアのCD-ROMを挿入します。
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2 AutoMountがサポートされていて有効になっている場合は、手順3に進みま

す。

-または-

システムがAutoMountをサポートしていない場合は、

次のコマンドを実行し、CD-ROMの内容をマウントします：

mount -t iso9660 -ro mode=0555 <device> <mount point>

「device」を使用マシンでのCD-ROM名に置き換え、「mount point」を希

望するマウント・ポイント名に置き換えます。例えば、/mnt上の第2 IDE

装置であるCD-ROMにマウントする場合、次のコマンドを実行します：

mount -t iso9660 -ro mode=0555 /dev/hdb /mnt

3 コマンド・ラインで、作業ディレクトリをマウント・ポイントに変更するための次

のコマンドを実行します：

cd /mnt

4 次のコマンドを実行し、プログラムのインストールを開始します：

sh ./linux/setup.bin

5 画面上の手順に従ってください。

ソフトウェアのアンインストール
Microsoft Windowsオペレーティング・システムで、このソフトウェアをアンインス

トールするには、コントロールパネルから以下の手順で行います：

1 コントロール パネルを開き、プログラムの追加と削除を選択します。現在イン

ストールされているプログラムの一覧が表示されます。

2 RCSを選択します。

3 変更と削除ボタンをクリックします。アンインストール・ウィザードが開きます。

4 アンインストールボタンをクリックし、画面上の手順に従います。

Microsoft Windowsオペレーティング・システムで、コマンド・ウィンドウからこのソ

フトウェアをアンインストールするには、以下の手順で行います：
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1 コマンド・ウィンドウを開き、RCSのインストール時に使用したインストール・デ

ィレクトリを指定します。 Windows 32ビット・オペレーティング・システムでの

デフォルト・パスは、プログラム・ファイル・ディレクトリです。

2 UninstallerDataサブディレクトリを指定し、次のコマンドを( クォーテーション・

マークも含めて)入力します：

“Uninstall IBM Virtual Console Software.exe”

アンインストール・ウィザードが開きます。画面上の手順に従ってください。

Linux稼動のシステムでこのソフトウェアをアンインストールするには、以下の手順

で行います：

1 コマンド・ウィンドウを開き、RCSのインストール時に使用したインストール・デ

ィレクトリを指定します。 Linuxシステムでのデフォルト・パスは/usr/lib です。

2 UninstallerDataサブディレクトリを指定し、次のコマンドを入力します：

% sh ./Uninstall_Dell_Remote_Console_Software

アンインストール・ウィザードが開きます。画面上の手順に従ってくださ

い。

ソフトウェアの起動
Microsoft Windowsシステムでソフトウェアを起動するには：

スタート → プログラム→ Dell RCS softwareを順に選択します。RCSソフトウェア

が起動します。

LinuxでRCSソフトウェアを起動するには：

アプリケーション・フォルダ( デフォルトでは/usr/lib/Dell_ Remote_ Console_

Switch_Software) から、次のコマンドを入力します。

./Dell_Remote_Console_Switch_Software

-または-

/user/binから次のリンクを入力します。

./Dell_Remote_Console_Switch_Software

-または-
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本製品がデフォルト以外のディレクトリにインストールされている場合には、次の

コマンドをシェルから実行します。

<パス>/Dell_Remote_Console_Switch_Software

-または-

インストール時にデスクトップにショートカットを作成してある場合は、ショートカッ

トをダブルクリックします。

スイッチとターゲット・デバイスの構成
このセクションでは、スイッチとターゲット・デバイスへのユーザー・アクセスの構成

手順の概要を説明します。スイッチに関する特定の情報については、スイッチの『

インストレーション／ユーザー･ガイド』を参照してください。

スイッチを追加するには、以下の手順で行います：

1 ソフトウェアをクライアント・コンピューター( 1台または複数台)にインストール

します。

2 クライアント・コンピューターでソフトウェアを起動します。

3 必要に応じてExplorerからユニット・プロパティやオプションの設定、その他の

カスタマイズを行います。

4 ローカルGUIインターフェイスを使用してすべてのターゲット・デバイスの名前

を構成します。

5 管理対象となる各スイッチで、手順3から6を繰り返します。

6 ソフトウェアの環境設定が完了したら、File → Database → Saveを順に選択

し、ローカル・データベースのコピーをすべての設定内容とともに保存します。

7 2台目のコンピューターでソフトウェアを起動し、ファイル→ データベース→

読み込みを順に選択して先ほど保存したファイルまで移動します。ファイルを

選択し、Loadをクリックします。セットアップ対象のクライアント・コンピュー

ターのすべてでこの手順を繰り返します。

8 スイッチに接続されているターゲット・デバイスにアクセスするには、Explorer

でターゲット・デバイスを選択し、Connect VideoまたはBrowseボタン(表示さ
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れるのは選択されたターゲット・デバイスに対応するボタンのみです)をクリッ

クして、セッションを開始します。

ユーザー・アカウントを構成するには、RCSソフトウェアを使用するか、また

はRemote Console Switchに統合されているWebインターフェイスから行います。

詳細については、『Dell Remote Console Switchインストレーション／ユーザー･ガ

イド』を参照してください。

Remote Console Switchを構成するには、以下の手順で行います：

1 付属のシリアル・ケーブルを使用して、端末あるいは端末エミュレーション・ソ

フトウェア稼動のPCをスイッチ背面パネルの設定ポートに接続します。 この

端末は、9600ボー、8ビット、1ストップ・ビット、パリティなし、フロー・コント

ロールなしに設定してください。

2 まず付属の電源コードをスイッチの背面に接続し、それから適切な電源コンセ

ントに差し込みます。

3 電源スイッチを入れると、ユニット背面の電源表示ランプが30秒間点滅し、セ

ルフテスト実行中であることを示します。 メイン・メニューにアクセスするに

は、Enterキーを押してください。

Remote Console Switchハードウェアの環境設定：

1 Mainメニューが表示されます。メニューには11のオプションがあります。オプ

ション1のNetwork Configurationを選択します。

2 オプション1を選択し、ネットワークの速度を設定します。速度を選択して設定

すると、Network Configuration Menu に戻ります。

3 オプション2を選択し、IP Configuration メニューを開きます。

4 以下のIPアドレス・タイプのなかから対応する番号を１つ入力して選択しま

す：1: None、2:IPv4 Static、3:IPv4 Dynamic、4：IPv6 Static、または5:Pv6

Dynamic。

5 Terminal Applicationsメニューからオプション3～5を順に選択し、Remote

Console SwitchのIPアドレス、Netmask、Default Gatewayの構成を終了しま

す。

6 上記の手順が完了したら、Øキーを押してMainメニューに戻ります。
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HTTPおよびHTTPSポートを構成するには：

1 Mainメニューが表示されます。メニューには11のオプションがあります。Set

Web Interface Portsのオプション番号を選択して、Web Interface Port

Configuration Menuを開きます。

2 オプション1を選択し、ポート番号を設定します。 HTTPポートおよびHTTPS

ポートに使用するポート番号を入力します。

3 ネットワークに対して正しい値が表示されていれば、Yとタイプして Enterキー

を押します。

4 ローカル・ユーザー・ステーションで、ターゲット・デバイス名を入力します。

マウス加速度

リモート･ビデオ･セッション中にマウスの反応が遅くなった場合は、ターゲット・デ

バイスのオペレーティング・システムでマウスの加速を無効にし、各ターゲット・デ

バイスでのマウスの加速をSlowまたはNoneに調整します。

Webインターフェイスのインストールとセットアップ
新しいアプライアンスのインストールが完了したら、Webインターフェイスを使用し

てユニット・パラメーターを設定し、ビデオ・セッションを起動できます。

サポートされているブラウザ

Webインターフェイスでは、以下のブラウザがサポートされています：

• Microsoft Internet Explorer® version 6.x SP1以降

• Firefoxバージョン2.0以降

OBWI( On-board Web Interface) の起動

Webインターフェイスは次の手順で起動します：

1 Webブラウザを開き、ローカルWebインターフェイスを使用してアプライアンス

のIPアドレスを入力します。
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注:シリアル･コンソールでデフォルトのHTTP/HTTPSポートを変更しており、IPv4アド
レスを使用している場合は、「https://<ipaddress>:<port#>」の形式でIPアドレスを入
力します。ここで、「port#」は、シリアル･コンソールで変更したポート番号となりま
す。IPv6アドレスを使用している場合は、「https://[<ipaddress>]:<port#>」の形式でIP
アドレスを入力します。ここで、「port#」は、シリアル･コンソールで変更したポート番
号となります。IPv6アドレスを使用している場合は、アドレスを角括弧で囲む必要が
あります。

2 ログイン・ウィンドウが開きます。ユーザー名とパスワードを入力し、OKをクリ

ックします。

注:デフォルトのユーザー名は「Admin」で、パスワードはなしです。

3 Webインターフェイスが開き、Connectionsタブが表示されます。

注: Webインターフェイスを使用するには、コンピューターに1.6.0_11以降のバージョン
のJava Runtime Environment( JRE) がインストールされている必要があります。
KVMスイッチは、コンピューターにJavaがインストールされているかどうかの検出を
試みます。 Javaがインストールされていない場合には、http://www.java.comからダ
ウンロードし、JNLPファイルをJava WebStartと関連付けてください。

注: Webインターフェイスにいったんログインすると、ログアウトした場合か、または管
理者が設定したアイドル・タイムアウトの時間枠を超過した場合を除き、新規セッショ
ンを起動する際にログインし直す必要はありません。
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基本のソフトウェア操作

RCSソフトウェアExplorer( 以降、Explorerと称します)は、本ソフトウェアの主要イ

ンターフェイス( GUI) です。 このExplorerから、サポートされているユニットすべて

の表示、アクセス、管理、カスタム・グループの作成を実行できます。

Explorerでのシステムの表示
ソフトウェアを起動すると、Explorerのメイン・ウィンドウが開きます。Explorerは以

下のペインに分割されています：ビュー選択タブ、グループ選択ペイン、およびユ

ニット選択ペイン。これらの領域の内容は、ターゲット・デバイスやアプライアンス

が指定されているか、またはどのタスクを実行するかにより異なります。図3.1に

は、これらの操作機能が示されています。

ビュー選択タブの一つをクリックし、Remote Console Switches、Servers、Sites、

およびFoldersのいずれかのカテゴリーでグループ分けされたシステムを表示しま

す。Explorerのデフォルト表示は、ユーザーによる設定が可能です。これらの4つ

のタブのいずれかを自動的に開くようにすることができます。詳細について

は、「Explorerでのシステムの表示」( ページ25) を参照してください。デフォルト表

示をカスタマイズしない場合、最初のRemote Console Switchが追加されていれ

ば、ExplorerはServersビューで表示されます。
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図3.1: Explorerウィンドウ

1 メニュー・バー： RCSソフトウェアの種々の機能には、ここからアクセスしま

す。

2 ビュー選択タブ：Explorerの表示形態を選択するためのビュー選択タブ4種が

含まれています。

3 グループ選択ペイン：現在のビュー選択タブで利用可能なグループ分けを表

すツリー構造が含まれています。Remote Console Switchesタブ、Sitesタブ、

またはFoldersタブを選択したときにユニット選択ペインに表示される内容は、

選択したグループにより決定されます。

4 ステータス・バー：ユニット リストに表示されるユニットの数を表示します。

5 ユニット選択ペイン：選択された表示形態またはグループに対応するSearch

バー、ユニット リスト、およびタスクボタンを含むものです。
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6 Searchバー： 検索ボックスに入力したテキストに基づいてデータベースを検

索できます。

7 ユニット・リスト：現在選択されているグループに含まれるユニットのユニット

リスト、またはSearchバーで実行した検索の結果を表示します。

8 タスク・ボタン：実行可能なタスクのボタンが含まれています。ボタンによって

は、ユニットリストで選択されたユニットの種類に基づいて変化するものや、

固定され、常に表示されるものがあります。

選択したスイッチがWebインターフェイスで有効になっている場合は、Explorerウィ

ンドウの下部に、ResyncとConfigure Applianceの2つのボタンが追加で表示され

ます。 Resyncボタンでは、電源が投入されていないSIPまたはAvocent IQモジ

ュールを検索できます。 Configure Applianceボタンでは、Remote Console

Switchをアップグレードできます。選択したスイッチがWebインターフェイスで有効

になっていない場合は、ResyncとConfigure Applianceのボタンは表示されませ

ん。

ウィンドウ表示のカスタマイズ
Explorerウィンドウは常時サイズ変更できます。アプリケーションを起動するたび

に、Explorerウィンドウはデフォルト設定のサイズと位置で開きます。

グループ選択ペインとユニット選択ペインは、画面を縦に走る分割ペイン・ディバ

イダーで分割されています。 この2つのペインの表示領域は、ディバイダーを左右

に動かすことで変更できます。ディバイダーは、Explorerを起動するたびにデフォ

ルトの位置に戻ります。ディバイダー・ペインとツリー表示制御のショートカットに

ついては、「キーボードとマウス」( ページ109) を参照してください。

起動時にどの表示形態で立ち上げるか(アプライアンス、デバイス、サイト、また

はフォルダ)は、Explorerで自動的に選択させることも、ユーザー指定にすること

も可能です。詳細については、「ウィンドウ表示のカスタマイズ」( ページ27) を参

照してください。

コラム上部の分類バーをクリックすると、ユニット・リストの順番や分類別を変更で

きます。コラムヘッダーの上向き矢印は、リストがこのフィールド名で昇順に配列

されていることを示します。下向き矢印は、リストがこのフィールド名で降順に配列

されていることを示します。
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Remote Console Switch( DellまたはAvocent)
の追加
RCSソフトウェアでは、Dell Remote Console Switchに加えて、アボセント製スイッ

チを管理することもできます。 したがって、お使いのRCSソフトウェアのデータ

ベースにRemote Console Switchを追加するプロセスの中で、追加するスイッチ

のベンダーと製品タイプを選択するように要求されます。Remote Console Switch

またはアボセント製スイッチが追加されると、ユニットリストに表示されます。手動

でRemote Console Switchを追加したり、探したりすることができます。ユニット

はIPv4またはIPv6のIPアドレスで追加することができます。

割り当てたIPアドレスで新規のRemote Console Switchを追加するには：

1 ExplorerメニューからFile →New →Remote Console Switchを順に選択しま

す。

-または-

New Remote Console Switchタスク・ボタンをクリックします。New

Remote Console Switchウィザードが表示されます。

2 Nextをクリックして続行します。Product Typeダイアログ・ボックスが表示さ

れ、Remote Console Switchのベンダーと製品の選択が要求されます。
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図3.2: Product Typeダイアログ・ボックス

3 Vendorを選択します。各ベンダーについて、サポートされる製品名が

Productリストに表示されます。製品を選択します。

追加するRemote Console Switchのモデルが、Productリスト内に存在し

ない場合は、Otherを選択します。この方法で追加したスイッチは、検出

後にProductリストに追加され、Remote Console Switchを次回追加する

際にはリストから選択できるようになります。

注: New Remote Console Switch Wizardの各ダイアログ・ボックスに、Productリストか
ら選択したスイッチの種類が表示されます。

4 Nextをクリックします。

5 Remote Console Switchに割り当てられたIPアドレスがあるかどうかを問うメッ

セージが表示されます。Yesをクリックした後、Nextをクリックします。
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6 Locateウィンドウが表示されます。ホスト名またはIPアドレス、HTTPポート、

およびHTTPSポー トを入力し、Next をクリ ックします。IPv4のアドレス

は、xxx.xxx.xxx.xxxのドット表記式で入力します。IPv6のアドレスは、16進数

のFD00:172:12:0:0:0:0:33の形式、またはFD00:172:12::33の圧縮形式で入力

します。

7 RCSソフトウェアは、指定されたユニットと、電源が投入されたSIP、Avocent

IQモジュール、およびサーバー名がある場合はこれらをすべて検索します。

電源が投入されていないSIPモジュールやAvocent IQモジュールを検索する

場合は、ソフトウェアの再同期機能にアクセスし、Include Offline SIPsチェッ

ク・ボックスをクリックして有効にします。

8 Nextをクリックします。

9 接続されているレガシー・スイッチがRCSソフトウェアによって検出された場合

は、Configure Tiered Switchesダイアログ・ボックスが表示されます。このダ

イアログ・ボックスには、Remote Console Switchから検索された全部のSIP

EIDのリスト、さらに、ケーブルが接続されているティアド・スイッチがある場合

はそれらも含まれます。このダイアログ・ボックスの初回表示の時点では、す

べてのスイッチはNoneに設定されています。検出されたスイッチには、ドロッ

プダウン・リストの隣にアイコンが表示されます。

a. Existing Tiered Switchesフィールドには、データベースで現在定義されて

いるスイッチ全部がリストされます。リストを変更する場合

は、Add、Modify、またはDeleteをクリックします。

b. スイッチに接続されているSIPモジュールまたはAvocent IQモジュールご

とに、ドロップダウン・リストから適切なスイッチを選択して関連付けます。
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図3.3: ConfigureTieredSwitchesダイアログ・ボックス

10 Remote Console Switch Wizardの最後のページに到達したら、Finishをクリッ

クしてウィザードを終了し、メイン・ウィンドウに戻ります。使用してい

るRemote Console Switchは、この段階でユニット選択ペインの表示になりま

す。

新たなRemote Console Switchで割り当てられたIPアドレスを持たないものを追加

するには：

1 ExplorerメニューからFile →New →Remote Console Switchを順に選択しま

す。

-または-

New Remote Console Switchタスク・ボタンをクリックします。New

Remote Console Switchウィザードが表示されます。
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2 Nextをクリックして続行します。Product Typeダイアログ・ボックスが表示さ

れ、Remote Console Switchのベンダーと製品の選択が要求されます。

図3.4: Product Typeダイアログ・ボックス

3 Vendorを選択します。各ベンダーについて、サポートされる製品名が

Productリストに表示されます。製品を選択します。

追加するRemote Console Switchのモデルが、Productリスト内に存在し

ない場合は、Otherを選択します。この方法で追加したスイッチは、検出

後にProductリストに追加され、Remote Console Switchを次回追加する

際にはリストから選択できるようになります。

4 Nextをクリックします。

5 Remote Console Switchに割り当てられたIPアドレスがあるかどうかを問うメッ

セージが表示されます。Noをクリックした後、Nextをクリックします。
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6 Network Addressウィンドウが表示されます。ユニットに割り当てるIPアドレ

ス、サブネット・マスク( IPv4モードの場合)またはプレフィックス長( IPv6モード

の場合) 、およびゲートウェイを入力し、Nextをクリックします。IPv4のアドレス

は、xxx.xxx.xxx.xxxのドット表記式で入力します。IPv6のアドレスは、16進数

のFD00:172:12:0:0:0:0:33の形式、またはFD00:172:12::33の圧縮形式で入力

します。

注: Remote Console Switchは、動的ホスト構成プロトコル( DHCP)および静的IPアド
レスをサポートしています。 Dellでは、IPアドレスをユニット毎に指定しておくこと、さ
らにRemote Console Switchユニットがネットワークに接続されている間はアドレスを
静的にしておくことをお薦めします。

7 Select Remote Console Switchウィンドウが表示され、検出された新し

いRemote Console Switchのリストから追加するユニットを選択するように求

めるメッセージが表示されます。製品を選択し、Nextをクリックします。

8 Configuring Remote Console Switchウィンドウが現れ、IP情報が正しく設定さ

れたかどうかが表示されます。構成が正しく実行された場合、ソフトウェアは新

しいRemote Console SwitchおよびすべてのSIP、Avocent IQモジュールと、

新しいRCSに対応するサーバー名を検索します。Nextをクリックします。

9 接続されているレガシー・スイッチがソフトウェアによって検出された場合

は、Configure Tiered Switchesダイアログ・ボックスが表示されます。このダ

イアログ・ボックスには、Remote Console Switchから検索されたSIPおよ

びAvocent IQモジュールのすべてのEIDと、SIPとAvocent AVRIQに接続され

ているティアド・スイッチがある場合はそのスイッチのリストが表示されます。

a. Existing Tiered Switchesフィールドには、データベースで現在定義されて

いるスイッチ全部がリストされます。リストは追加、削除または変更ができ

ます。

b. スイッチに接続されているSIPモジュールまたはAvocent IQモジュールご

とに、ドロップダウン・リストから適切なスイッチを選択して関連付けます。
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図3.5: ConfigureTieredSwitchesダイアログ・ボックス

10 終了したら、Finishをクリックして、ウィザードを終了しメイン・ウィンドウに戻り

ます。使用中のRemote Console Switchは、この時点でユニット選択ペイン内

に表示されるはずです。

Remote Console Switchを見つけるには：

1 ソフトウェアのExplorerメニューから、Tools → Discoverを順に選択しま

す。Discover Wizardが表示されます。Nextをクリックして続行します。

2 Address Rangeページが表示されます。次の手順のいずれかを実行します：

IPv4モードを使用している場合、Use IPv4 address rangeを選択し、検索す

るIPアドレスの範囲をTo AddressとFrom Addressの各欄に入力しま

す。IPv4のアドレスは、xxx.xxx.xxx.xxxのドット表記式で入力します。

-または-
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IPv6モードを使用している場合、Use IPv6 address rangeを選択し、検索す

るIPアドレスの範囲をTo AddressとFrom Addressの各欄に入力しま

す。IPv6のアドレスは、16進数のFD00:172:12:0:0:0:0:33の形式、また

はFD00:172:12::33の圧縮形式で入力します。

3 Remote Console Switchがシリアル・コンソールでデフォルト設定から変更さ

れている場合には、HTTPとHTTPSのデフォルトのポート番号も変更できま

す。これには、新しいポート番号をHTTP PortとHTTPS Portのフィールドに入

力します。Nextをクリックして続行します。

4 Searching Networkという進行状態を示すバーが表示されます。進行状態を示

すテキストに、範囲指定された合計数のうち何個のアドレスが検索されたかが

示され、また見つかったRemote Console Switchの数、またはアボセント製ス

イッチの数が示されます。1台またはそれ以上の新しいRemote Console

SwitchまたはAvocentスイッチが検索されると、ウィザードは「Select Remote

Console Switches to Add」のページを表示します。このページから、ローカ

ル・データベースに追加するRemote Console Switchを選択できます。

-または-

新しいRemote Console Switchが見つからない場合(またはStopをクリッ

クした場合)は、ウィザードによってNo New Remote Console Switches

Foundページが表示されるので、手動でスイッチを追加する必要がありま

す。詳細については、この前の手順説明を参照してください。

5 追加するRemote Console Switchをクリックし、Add( >) ボタンをクリックして、

選択項目をRemote Console Switches to Addリストに移動します。
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図3.6: Select RemoteConsole Switches toAddダイアログ・ボックス

6 追加するRemote Console Switchのすべてについて手順5を繰り返しま

す。Nextをクリックして続行します。

7 新しいスイッチが追加される間、Adding Remote Console Switchesという進行

状態を示すバーが表示されます。選択されたスイッチがすべてローカル・デー

タベースに追加されると、Discover Wizard Completedページが表示されま

す。Finishをクリックしてウィザードを終了し、メイン・ウィンドウに戻ります。新

しいスイッチはこの時点でユニット選択ペインに含まれているはずです。

8 何らかの理由で(追加プロセスの間にStopをクリックした場合を含め) 1つまた

は複数のスイッチがローカル・データベースに追加できなかった場合

は、Discover Wizard Not All Remote Console Switches Addedページが表示

されます。このページには、選択したスイッチ全部とそれぞれのステータスが

リストされます。ステータスで、Remote Console Switchがローカル・データ
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ベースに追加された場合はその旨が、されなかった場合には行われなかった

理由が表示されます。リストの参照が終わったら、Doneをクリックします。

注:同一のIPアドレスを持つRemote Console Switchがユニット検出時にデータベー
スに存在する場合には、検出されたスイッチは無視され、次のウィザード・ページ上
には表示されません。

Remote Console Switchのアクセス
ソフトウェアのRemote Console Switchesタブをクリックすると、ローカル・データ

ベースで現在定義されているスイッチのリストが表示されます。 Remote Console

Switchにアクセスするには、まずユーザー名とパスワードを入力してログインしな

ければなりません。デフォルトのユーザー名は、パスワードなしのAdmin( 大文字

と小文字の区別あり)です。 特定のRemote Console Switchにログインすると、ソ

フトウェアのセッションの間、ソフトウェアはユーザー名とパスワードをメモリーの

キャッシュに保存します。

注:ログイン・アカウント情報をクリアして別のユーザー名とパスワードで再ログイン
する場合は、Tools→Clear Login Credentialsを順に選択します。

図3.7: RemoteConsole Switchのビュー・タブが選択された状態
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Remote Console Switchへログインするには：

1 ExplorerでRemote Console Switchesタブをクリックします。

2 ユニット選択ペインのRemote Console Switchをダブルクリックします。

-または-

ユニット選択ペインでRemote Console Switchを選択し、Configure

Remote Console Switchタスク・ボタンをクリックします。

-または-

ユニット選択ペインのRemote Console Switchを右クリックします。ポップ

アップ・メニューが表示されます。Configure Remote Console Switchesを

選択します。

-または-

ユニット選択ペインのRemote Console Switchをクリックして、Enterキー

を押します。

3 利用できる場合は、キャッシュに保存されているログイン・アカウント情報が

使用されます。 利用できない場合は、ログイン・プロンプトが表示されます。

ユーザー名とパスワードを入力します。 今回がRemote Console Switchへの

最初のアクセスである場合、またはユーザー名とパスワードが割り当てられ

ていない場合は、デフォルトのユーザー名であるAdmin( 大文字と小文字を区

別)をパスワードなしで入力します。

4 OKをクリックして、Remote Console Switchにアクセスします。これによ

り、OBWIが起動します。OBWIの詳細については、『Remote Console Switch

インストーラ／ユーザー・ガイド』を参照してください。

-または-

Cancelをクリックし、ログインせずに終了します。

システム内でRemote Console Switchを検索するには：

1 ソフトウェアでRemote Console Switchタブをクリックし、検索テキスト・ボック

スにカーソルを置きます。
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2 検索情報を入力します。この情報には、Remote Console Switchの名前また

は他のユニット選択リストの見出しに入力した情報( Type、Location、IPアドレ

スなど)が使用できます。

3 Search ボタンをクリックします。結果はユニットリストに表示されます。

4 検索の結果を参照します。

-または-

Clear Resultsボタンをクリックし、リスト全体をもう一度表示します。

VNCまたはRDPビューアの起動
RCSソフトウェアは、ユーザー定義のVirtual Network Computing( VNC) およ

びRemote Desktop Protocol( RDP) のビューアをサポートしています。VNCまた

はRDPビューアを起動するには、RCSソフトウェアのExplorerからServerタブを選

択します。ユニット・リストからサーバーを選択し、画面の右下にあるVNCまた

はRDPボタンをクリックします。

注: 「VNC」ボタンおよび「RDP」ボタンは、サーバーでリンクが設定されている場合に
のみ表示されます。 詳細については、VNCとRDPのプロパティとオプションのセクシ
ョンを参照してください。

サーバーとスイッチのプロパティの変更
ソフトウェアで、General、Network、Information、 Connections( デバイス

用) 、VNCおよびRDP( ビューア・アプリケーション用) のタブにあるPropertiesダイ

アログ・ボックスから、個々のサーバーまたはスイッチのプロパティを変更できま

す。

一般プロパティ

Generalタブでは、Remote Console Switchや接続されているサーバーの名前と表

示アイコンを変更できます。スイッチやサーバーを、特定のサイトやロケーション、

またはフォルダに割り当てることもできます。さらにサーバーについては、種類を

変更することもできます。

一般プロパティを変更するには：
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1 ソフトウェアでRemote Console SwitchesタブまたはServersタブをクリックし、

ユニット選択リストからユニットを1つ選択します。

2 Explorer メニューからView →Propertiesを順に選択します。

-または-

Propertiesタスク・ボタンをクリックします。

-または-

ユニットを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

図3.8:サーバーのGeneral Propertiesタブ

3 ユニットの名前を入力します。既存名と同一の名称は使用できません。

4 ( オプション：サーバーのみ)サーバーの種類を選択します。 ドロップダウン・

リスト内に選択項目がない場合、テキスト・フィールドに新しいサーバーの種

類の名称を入力します。一度入力されると、それ以降の割り当てのドロップダ

ウン・リストで、このオプションが使用できるようになります。

5 このユニットを表すアイコンを選択します。
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6 ( オプション)ユニットをサイト、部門、またはロケーションに割り当てます。 オ

プションがドロップダウン・リストにない場合は、テキスト・フィールドに新規の

割り当て名を入力します。一度入力されると、それ以降の割り当てのドロップ

ダウン・リストで、このオプションが使用できるようになります。

7 Applyをクリックして新しい設定を保存します。

-または-

OKをクリックして新しい設定を保存し、Propertiesウィンドウを閉じます。

-または-

Cancelをクリックして、新しい設定を保存せずに終了します。

サーバーのネットワーク・プロパティ

Networkタブでは、ビューア・セッションを起動せずに、サーバーのWebサーバー

にブラウザを起動する場合の、サーバーのブラウザURLを設定できます。

ネットワーク・プロパティを変更するには：

1 ソフトウェアでServersタブをクリックした後で、ユニット選択リストからサー

バーを1つ選択します。

2 Explorer メニューからView →Propertiesを順に選択します。

-または-

Propertiesタスク・ボタンをクリックします。

-または-

ユニットを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

3 Networkタブをクリックして、ブラウザでサーバーに接続する際に使用す

るURLを入力します。フィールドに値が含まれている場合には、タスク・バー

にBrowseボタンが表示され、指定されたURLに対するブラウザを立ち上げる

ことができるようになります。

4 Applyをクリックして新しい設定を保存します。

-または-

OKをクリックして新しい設定を保存し、ウィンドウを閉じます。

-または-
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Cancelをクリックして、新しい設定を保存せずに終了します。

スイッチのネットワーク・プロパティ

ネットワークの再構成を行う場合は、NetworkタブでスイッチのIPアドレスを変更で

きます。

ネットワーク・プロパティを変更するには：

1 ソフトウェアでRemote Console Switchesタブをクリックした後で、ユニット選

択リストからユニットを1つ選択します。

2 Explorer メニューからView →Propertiesを順に選択します。

-または-

Propertiesタスク・ボタンをクリックします。

-または-

ユニットを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

3 Networkタブをクリックして、Remote Console Switchのアドレスを入力しま

す。このフィールドには、IPドット表記やドメイン名も入力できます。既に使用さ

れているアドレスは使用できません。またフィールドは空欄のままにすること

はできません。最高で128文字を入力でき、IPv4またはIPv6アドレスのどちらも

使用できます。または、IPv4とIPv6を同時にデュアルスタックできます。

注: Dell 1081ADおよび2161ADスイッチは、IPv4とIPv6モードの同時使用には対応し
ていません。

4 シリアル・コンソールでRemote Console Switchのポート番号を変更した場合

は、HTTPおよびHTTPSのポート番号をHTTP PortとHTTPS Portのフィール

ドにそれぞれ入力します。シリアル・コンソールでのポート番号の変更につい

ては、「HTTP/HTTPSオプション」( ページ50) を参照してください。

5 Applyをクリックして新しい設定を保存します。

-または-

OKをクリックして新しい設定を保存し、ウィンドウを閉じます。

-または-

Cancelをクリックして、新しい設定を保存せずに終了します。
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情報プロパティ

Informationタブでは、説明、連絡先情報や追加コメントなどのスイッチやサーバー

に関連した情報を入力できます。

情報プロパティを変更するには：

1 ソフトウェアでRemote Console SwitchesタブまたはServersタブをクリックし、

ユニット選択リストからユニットを1つ選択します。

2 Explorer メニューからView →Propertiesを順に選択します。

-または-

Propertiesタスク・ボタンをクリックします。

-または-

ユニットを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

3 ( オプション) Informationタブをクリックし、ユニットの説明を入力します。下記

のフィールドには任意の情報を保存できます。

a. Descriptionフィールドには、最大128文字の説明を入力します。

b. Contactフィールドには、最大128文字の説明を入力します。

c. Contact Phone Numberフィールドには、最大64文字の説明を入力しま

す。

d. Commentsフィールドには、最大256文字の説明を入力します。

4 Applyをクリックして新しい設定を保存します。

-または-

OKをクリックして新しい設定を保存し、ウィンドウを閉じます。

-または-

Cancelをクリックして、新しい設定を保存せずに終了します。

サーバーの接続プロパティ

Connectionsタブには、選択したサーバーへのアクセスに使用される物理接続パ

スと、ビデオなどの接続のタイプが表示されます。
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接続プロパティを表示するには：

1 ソフトウェアでServersタブをクリックした後で、ユニット選択リストからサー

バーを1つ選択します。

2 Explorer メニューからView →Propertiesを順に選択します。

-または-

Propertiesタスク・ボタンをクリックします。

-または-

サーバーを右クリックして、Propertiesを選択します。Propertiesダイアロ

グ・ボックスが表示されます。

3 Connectionsタブをクリックし、サーバーの接続を表示します。Connectionsプ

ロパティは、サーバーのみが利用でき、読み取り専用です。このデバイスへの

アクセスに使用される物理的接続パスと、ビデオなどの接続の種類が表示さ

れます。

4 プロパティの確認後は、OKまたはCancelをクリックしてウィンドウを閉じます。

VNCプロパティ

ユーザー指定のVNCアプリケーションを指定する場合、コマンド・ライン引数を含

めることができます。コマンド・ラインの配置についてマクロを選択できます。これ

は、IPアドレス、ポート番号、ユーザー名、パスワードなどの変数を自動置換する

場合に便利です。 Windows、Linux、およびUNIX® オペレーティング・システムが

動作するコンピューター用の独自のGUIを持たないVNCコマンドの場合、OSのコ

マンド・ウィンドウからVNCアプリケーションを起動させることができます。

VNCプロパティを変更するには：

1 ユニット・リストからサーバーを選択します。

2 Remote Console SwitchのExplorerメニューからView → Propertiesを順に選

択します。

-または-

Propertiesタスク・ボタンをクリックします。

-または-
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ユニットを右クリックします。ポップアップ・メニューからPropertiesを選択

します。Propertiesダイアログ・ボックスが表示されます。

3 VNCタブをクリックします。

4 サーバーの場合のみ、IPアドレス・フィールドに、IPアドレス( ドット表記法)また

はドメイン名( 1～128文字) を入力します。スペースは使用できません。重複

したアドレスも使用できます。 IPv4およびIPv6のアドレスを使用できます。

5 Portフィールドにポート番号( 23～65535) を入力します。 空欄の場合はポー

ト23が使用されます。

6 Use Defaultチェック・ボックスを有効( チェック印をつける)または無効(チェッ

ク印を外す) にします。この設定が有効になっている場合、Optionsで指定さ

れたデフォルトのグローバル設定が使用され、Application to Launch領域の

他の部分はすべて無効になります。

7 ディレクトリ・パスおよび名前を入力するか、Browseボタンをクリックしてパス

と名前を指定します。

8 パスおよび名前の下のボックスに、コマンド・ライン引数を入力します。

-または-

コマンド・ラインのカーソル位置に事前定義されたマクロを挿入するに

は、Insert Macroリスト・ボックスをクリックしてドロップダウン・メニューか

らマクロを選択します。RCSソフトウェアは、アプリケーションの実行時に

これらの変数を自動的に置換します。

9 Launch in command windowチェック・ボックスを有効または無効にします。有

効になっている場合、ユーザー指定のVNCアプリケーションがOSのコマンド・

ウィンドウから起動します。

10 OKをクリックします。

RDPプロパティ

ユーザー指定のRDPアプリケーションを指定する場合、コマンド・ライン引数を含

めることができます。コマンド・ラインの配置についてマクロを選択できます。これ

は、IPアドレス、ポート番号、ユーザー名、パスワードなどの変数を自動置換する

場合に便利です。 Windows、Linux、およびUNIX® オペレーティング・システムが
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動作するコンピューター用の独自のGUIを持たないRDPコマンドの場合、OSのコマ

ンド・ウィンドウからRDPアプリケーションを起動させることができます。

RDPプロパティを変更するには：

1 ユニット・リストからサーバーを選択します。

2 Remote Console SwitchのExplorerメニューからView → Propertiesを順に選

択します。

-または-

Propertiesタスク・ボタンをクリックします。

-または-

ユニットを右クリックします。ポップアップ・メニューからPropertiesを選択

します。Propertiesダイアログ・ボックスが表示されます。

3 該当する場合は、RDPタブをクリックします。

4 サーバーの場合のみ、IPアドレス･フィールドに、IPアドレス( ドット表記法)また

はドメイン名( 1～128文字) を入力します。スペースは使用できません。重複

したアドレスも使用できます。 IPv4アドレスまたはIPv6アドレスを使用できま

す。または、IPv4とIPv6のアドレスを同時に使用できます。

注: Dell 1081ADおよび2161ADスイッチは、IPv4とIPv6モードの同時使用には対応し
ていません。

5 Portフィールドにポート番号( 23～65535) を入力します。 空欄の場合はポー

ト23が使用されます。

6 Use Defaultチェック・ボックスを有効( チェック印をつける)または無効(チェッ

ク印を外す) にします。この設定が有効になっている場合、Optionsで指定さ

れたデフォルトのグローバル設定が使用され、Application to Launch領域の

他の部分はすべて無効になります。

7 ディレクトリ・パスおよび名前を入力するか、Browseボタンをクリックしてパス

と名前を指定します。

8 パスおよび名前の下のボックスに、コマンド・ライン引数を入力します。

-または-
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コマンド・ラインのカーソル位置に事前定義されたマクロを挿入するに

は、Insert Macroリスト・ボックスをクリックしてドロップダウン・メニューか

らマクロを選択します。RCSソフトウェアは、アプリケーションの実行時に

これらの変数を自動的に置換します。

9 Launch in command windowチェック・ボックスを有効または無効にします。有

効になっている場合、ユーザー指定のRDPアプリケーションがOSのコマンド・

ウィンドウから起動します。

10 OKをクリックします。

ブラウザ・ウィンドウを介したサーバーへのアクセス

必要に応じて、Webブラウザでサーバーに接続するようにソフトウェアを構成でき

ます。まずサーバーを選択し、Propertiesダイアログ・ボックスでそのサーバー

のWebサーバー・ネットワークを設定します。その後は、サーバーを選択する

と、Browseタスク・ボタンが表示されます。

注: ExplorerのOptionsダイアログ・ボックスで使用するブラウザを選択することができ
ます。

注:ブラウザではどのURLにも接続できますが、サーバーに対するBrowser Network
プロパティが設定されている場合、この機能はサービス・プロセッサー管理インター
フェイス( integrated Dell Remote Access Card (iDRAC) など)で設定したサーバーに
特に適切となります。

ブラウザ・ウィンドウでサーバー・ネットワークを起動するには：

1 ソフトウェアのユニット選択ペインでサーバーを選択します。

2 このサーバーのネットワークのブラウザURLをPropertiesダイアログ・ボック

スで定義している場合は、Browseタスク・ボタンが表示されます。Browseタス

ク・ボタンをクリックします。確認したURLがブラウザ・ウィンドウで開きます。

サーバーとスイッチのオプションの変更
RCSソフトウェアのOptionsダイアログ・ボックスから、General、HTTP/HTTPS

Ports、VNC、およびRDPなどのサーバーやスイッチのオプションを個別に変更で

きます。

一般オプション

カスタム・フィールド・ラベルを変更するには：



48xxx |基本のソフトウェア操作xxx

1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアロ

グ・ボックスが表示されます。

図3.9: Optionsダイアログ・ボックスのカスタム・フィールド・ラベル

2 変更するフィールド・ラベルを選択し、Modifyボタンをクリックします。Modify

Custom Field Labelダイアログ・ボックスが表示されます。

3 このフィールドラベルを単数形と複数形で入力します。 有効な文字長

は、1～32文字です。空欄にすることはできません。スペースの使用は中間

では構いませんが、最初と最後には使用できません。

4 OKをクリックして、新しいフィールド・ラベルを保存します。

-または-

Cancelをクリックすると、変更を保存しないで終了します。

デフォルト・ブラウザ

ブラウザ・オプションでは、URLが指定されているターゲット・デバイスのBrowseボ

タンをクリックしたとき、またはRCSオンライン・ヘルプにアクセスしたときに起動す
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るブラウザを指定します。現在のコンピューターでのデフォルト・ブラウザをオンに

するか、または利用可能な他のブラウザから選んでください。

デフォルト・ブラウザの表示または変更は、以下の手順で行います：

1 ExplorerメニューからTools →Optionsを順に選択します。General Optionsウ

ィンドウが開きます。

2 次の手順のいずれかを実行します：

• Browserフィールドで、Launch Default Browserチェック・ボックスを選択

してデフォルトのブラウザを指定します。

• Launch Default Browserチェック・ボックスの選択を解除します。Browse

ボタンをクリックし、このコンピューターで使用できるブラウザを選択しま

す。また、使用可能なブラウザのフル・パスを入力することもできます。

3 次の手順のいずれかを実行します：

• 別のタブをクリックして異なるプロパティの変更を行います。

• 完了したらOKをクリックして、新しい設定を保存します。

• Cancelをクリックして、新しい設定を保存せずに終了します。

DirectDrawサポートの変更(Windows OSのみ)

このソフトウェアはDirectDrawをサポートしています。DirectDrawは、ビデオ表示

メモリー、ハードウェア・オーバーレイ、およびページ・フリッピングを、グラフィカ

ル・デバイス・インターフェイス( GDI) を介さず、直接操作できるようにする規格で

す。 DirectDrawを採用することで、よりスムーズなアニメーションや、動画・画像

ディスプレイの多いソフトウェアでのよりよい性能が得られます。

ただし、使用機器でソフトウェア・カーソルやポインターのシャドー機能を有効にし

ている場合や、ビデオ・ドライバーがDirectDrawをサポートしていない場合には、

ビューアのタイトル・バー上にマウスカーソルを合わせた時にフリッカー(点滅) 現

象が起きることがあります。

ソフトウェアのカーソルまたはポインター・シャドウを無効にするか、ビデオ・カード

に新しいドライバーを読み込む、またはDirectDrawを無効にすることもできます。

DirectDrawを無効にするには：
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1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアロ

グ・ボックスが表示されます。

2 DirectDrawチェック・ボックスをクリックして無効にします。

3 OKをクリックします。

注: DirectDrawチェックボックスは、Windowsベースのオペレーティング・システムの
場合にのみ表示されます。

HTTP/HTTPSオプション

Remote Console Switchとソフトウェアでは、ポート80をデフォルトのHTTPポート

に、ポート443をデフォルトのHTTPSポートとして使用します。デフォルト・ポート番

号は、Optionsダイアログ・ボックスのHTTP/HTTPS Portsタブで変更できます。

1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアロ

グ・ボックスが表示されます。

2 HTTP/HTTPSポートタブをクリックします。

3 HTTPおよびHTTPSポートの新しいデフォルト・ポート番号を入力します。

4 OKをクリックします。

VNCオプション

このソフトウェアは、プロパティ・ページを介してユーザー定義のVNCビューアをサ

ポートしています。 VNCタブではユーザー指定のVNCアプリケーションを検索でき

ます。そのコマンド・ライン引数を含めることもできます。コマンド・ラインの配置に

ついてマクロを選択できます。これは、IPアドレス、ポート番号、ユーザー名、パス

ワードなどの変数を自動置換する場合に便利です。標準のWindows、Linux、およ

びUNIX用の独自のGUIを持たないVNCコマンドの場合、OSのコマンド・ウィンドウ

からVNCアプリケーションを起動させることができます。

VNCオプションを変更するには：

1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアロ

グ・ボックスが表示されます。

2 VNCタブをクリックします。
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3 Application to Launchフィールドに、ディレクトリ・パスおよび名前を入力する

か、Browseボタンをクリックしてパスと名前を指定します。

4 パスおよび名前の下のボックスに、コマンド・ライン引数を入力します。

-または-

コマンド・ラインのカーソル位置に事前定義されたマクロを挿入するに

は、Insert Macroリスト・ボックスをクリックしてドロップダウン・メニューか

らマクロを選択します。RCSソフトウェアは、アプリケーションの実行時に

これらの変数を自動的に置換します。

5 Launch in command windowチェック・ボックスを有効または無効にします。有

効になっている場合、ユーザー指定のVNCアプリケーションがOSのコマンド・

ウィンドウから起動します。

6 OKをクリックします。

RDPオプション

このソフトウェアは、プロパティ・ページを介してユーザー定義のRDPビューアをサ

ポートしています。 RDPタブではユーザー指定のRDPアプリケーションを検索でき

ます。そのコマンド・ライン引数を含めることもできます。コマンド・ラインの配置に

ついてマクロを選択できます。これは、IPアドレス、ポート番号、ユーザー名、パス

ワードなどの変数を自動置換する場合に便利です。標準のWindows、Linux、およ

びUNIX用の独自のGUIを持たないRDPコマンドの場合、OSのコマンド・ウィンドウ

からRDPアプリケーションを起動させることができます。

RDPオプションを変更するには：

1 Explorerメニューで、Optionsダイアログ・ボックスが表示されます。

2 RDPタブをクリックします。

3 Application to Launchフィールドに、ディレクトリ・パスおよび名前を入力する

か、Browseボタンをクリックしてパスと名前を指定します。

4 パスおよび名前の下のボックスに、コマンド・ライン引数を入力します。

-または-

コマンド・ラインのカーソル位置に事前定義されたマクロを挿入するに

は、Insert Macroリスト・ボックスをクリックしてドロップダウン・メニューか
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らマクロを選択します。RCSソフトウェアは、アプリケーションの実行時に

これらの変数を自動的に置換します。

5 Launch in command windowチェック・ボックスを有効または無効にします。有

効になっている場合、ユーザー指定のRDPアプリケーションがOSのコマンド・

ウィンドウから起動します。

6 OKをクリックします。

システムの編成
RCSソフトウェアでSitesおよびFoldersの表示タブを使用すると、Remote Console

Switchとサーバーをカスタム・グループ別に編成し、管理できます。サイトの整理

方法はサーバーが配置されている場所に基づき、コラムヘッダーであるサイトと

部門として表示されますが、これらはニーズに合わせてカスタマイズできます。「カ

スタム・フィールド名の変更」( ページ53) を参照してください。フォルダを使用する

ことで、個々のサーバー用に、カスタマイズした編成システムを作成することがで

きます。例えば、重要なサーバーやリモートサーバー用のフォルダを作成すること

などができます。

コラム・ヘッダーをクリックすると、ユニット選択リストの順番や分類別を変更でき

ます。コラムヘッダーの上向き矢印は、リストがこのフィールド名で昇順に配列さ

れていることを示します。下向き矢印は、リストがこのフィールド名で降順に配列さ

れていることを示します。

コラムヘッダーはカスタマイズすることができます。図3.10は、フィールド名のデフ

ォルト値の使い方の例を示しています。これらは組織に合わせて変更できます。

図3.11に、カスタマイズされたフィールド名の例を示します。
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図3.10: Sitesのビュー選択タブが選択された状態

カスタム・フィールド名の変更

カスタム・フィールド名を使用すると、ソフトウェアのグループ選択ペインやユニッ

ト選択ペインに表示されるSite、Department、およびLocationの各コラム・ヘッ

ダー名を変更できます。これにより、ユーザーが使いやすい形でRemote Console

Switchとサーバーのグループ分けができるようになります。Departmentフィール

ドは、Siteのサブセットです。これらのフィード名をカスタマイズする場合は、この階

層構造に留意して行ってください。

図3.11:変更したカスタム・フィールドの例
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新しいサイト、部門、またはロケーションを作成するには：

1 Explorer メニューからView →Propertiesを順に選択します。

-または-

Propertiesタスク・ボタンをクリックします。Propertiesダイアログ・ボック

スが表示されます。

2 Generalタブをクリックし、ドロップダウン・リストからSite、Department、また

はLocationを選択します。名前がドロップダウン・リストにない場合は、テキス

ト・フィールドに希望する名前を入力します。名前は1～32文字の範囲で指定

します。名前にはキーボードから入力できる文字を任意に組み合わせて使用

できます。また大文字と小文字の区別はありません。スペースの使用は中間

では構いませんが、最初と最後には使用できません。既存名と同一の名称は

使用できません。

3 OKをクリックします。新しいサイト、部門またはロケーションがグループ選択

ペインに表示されます。

フォルダの作成

新しいフォルダを作成するには：

1 Foldersのビュー選択タブを選択します。

2 Foldersノード上でクリックし、File →New →Folderを順に選択します。

-または-

Foldersノードを右クリックし、New Folderを選択します。New Folderダイア

ログ・ボックスが表示されます。

3 フォルダ名を1～32文字の範囲で指定します。フォルダ名にはキーボードから

入力できる文字を任意に組み合わせて使用できます。また大文字と小文字の

区別はありません。スペースの使用は中間では構いませんが、最初と最後に

は使用できません。 同じレベルでは同一のフォルダ名は使用できませんが、

異なるレベル間では使用可能です。

4 OKをクリックします。新しいフォルダがグループ選択ペインに表示されます。
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ユニットのサイト、ロケーション、またはフォルダへの割当

ソフトウェアで、サイト、部門、ロケーションまたはフォルダにRemote Console

Switchまたはサーバーを割り当てることができます。このメニュー項目は、ユニッ

ト選択ペイン内で単一のRemote Console Switchまたはサーバーが選択されてい

るときのみに有効となります。これらのカスタム・ターゲットは、General Properties

ダイアログ・ボックスで定義されています。

ユニットをサイト、ロケーション、またはフォルダへ割り当てるには：

1 ユニット選択ペインでサーバーを選択します。

2 ExplorerメニューからEdit → Assignを順に選択します。

-または-

Assign Toタスク・ボタンをクリックします。

-または-

ユニットを右クリックしてAssign Toを選択します。Assign Toダイアログ・ボ

ックスが表示されます。

3 サイト、ロケーションまたはフォルダ・カテゴリーをドロップダウン・リストから選

択します。

4 選択されたカテゴリーの範囲内で、使用可能なターゲットのリストから、ユニッ

トを割り当てられるターゲットを選択します。サイト、ロケーション、またはフォ

ルダがローカル・データベース内で定義されていない場合には、このリストは

空欄になります。

5 OKをクリックして割り当てを保存します。

-または-

Cancelをクリックすると、変更を保存しないで終了します。

ユニットをサイト、部門、ロケーション、またはフォルダにドラッグ・アンド・ドロップ

するには：

1 ソフトウェアのユニットリスト内でユニットをクリックし、マウスをそのまま保持

します。
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2 このユニットを、グループ選択ペインのツリー表示内にあるノードにドラッグし

ます。

3 マウス・ボタンを放します。そのノードをクリックすると、この項目がユニットリ

ストに表示されます。

注:ユニットは、すべての部門、すべてのユニット、またはサイトのルート・ノードには
移動できません。 ユニットは一度に一つずつしか移動できません。

削除および名前の変更

削除機能は、ソフトウェアのグループ選択ペインとユニット選択ペインでの現在の

選択内容に基づく状況依存型の機能です。 ユニット・リストのユニットを選択して

削除すると、ユニットはローカル・データベースから削除されます。グループ選択

ペインのツリー表示で項目を選択し削除する場合、サーバーの種類、サイト、部

門、およびフォルダも削除されます。ただし、いずれの操作を行っても、ユニットは

ローカル・データベースからは削除されません。

名前の変更機能も状況依存型です。ユニットリストからRemote Console Switchま

たはサーバーを選択し、名前を変更することができます。グループ選択ペインのツ

リー表示でも、サーバーの種類、サイト、部門およびフォルダ名を選択して名前を

変更することができます。

Remote Console Switchまたはサーバーを削除するには：

1 ユニット選択ペインから削除するユニットを選択します。

2 Edit → Deleteの順に選択します。

-または-

キーボードのDelキーを押します。削除するユニットの数の確認を求める

ダイアログ・ボックスが現れます。Remote Console Switchを削除する場

合、ダイアログ・ボックスにDelete Associated Servers チェックボックス

が表示されます。必要に応じ、チェックボックスをクリックして有効／無効

にします。

3 Yesをクリックして削除を確認します。設定によっては、この他にも別のメッ

セージが表示される場合があります。該当する場合は対応してくださ

い。Remote Console Switchまたはサーバーが削除されます。

-または-
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Noをクリックしてキャンセルします。

サーバーの種類、サイト、部門またはフォルダを削除するには：

1 グループ選択ペインから削除するサーバー・タイプ、サイト、部門またはフォ

ルダを選択します。

2 Edit → Deleteの順に選択します。

-または-

キーボードのDelキーを押します。 削除されるユニットの数の確認を求め

るダイアログ・ボックスが現れます。

3 Yesをクリックして削除を確認します。設定によっては、この他にも別のメッ

セージが表示される場合があります。該当する場合は対応してください。アイ

テムが削除されます。

-または-

Noをクリックしてキャンセルします。

ユニット、サイト、部門またはフォルダの名前を変更するには：

1 RCSソフトウェアで、グループ選択ペインから削除するサーバー・タイプ、サイ

ト、部門またはフォルダを選択します。

2 Edit → Renameの順に選択します。Renameダイアログ・ボックスが表示され

ます。

3 フォルダ名を1～32文字の範囲で指定します。 名前にはキーボードから入力

できる文字を任意に組み合わせて使用できます。また大文字と小文字の区別

はありません。スペースの使用は中間では構いませんが、最初と最後には使

用できません。同一の名前は、次の2つの例外を除いては使用できません。同

一の部門名は異なるサイト間であれば使用可能であり、また同一フォルダ名

は異なるレベルの間であれば使用可能です。

4 OKをクリックして、新しい名前を保存します。

Explorerウィンドウのカスタマイズ
RCSソフトウェアのExplorerウィンドウのサイズはいつでも変更可能です。アプリ

ケーションを起動させるたびに、Explorerウィンドウはデフォルトのサイズと位置で
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開きます。アプリケーション実行中に手動でウィンドウ・サイズを変更することはで

きますが、その情報は保存されません。つまり、Explorerを次回起動させる際に、

再びデフォルトのサイズと位置で開くことになります。

グループ選択ペインとユニット選択ペインは、画面を縦に走る分割ペイン・ディバ

イダーにより分割されています。ディバイダーを左右に移動すると、グループ選択

ペインとユニット選択ペインの表示領域を変更できます。Explorerを起動するたび

に、ディバイダーはデフォルト位置に戻ります。

スタートアップ時の指定表示の変更

スタートアップ時のオプションのSelectedビューの下でDefaultがチェックされてい

る場合、表示内容はExplorerにより決定されます。1つまたは複数のサーバーが

定義されている場合は、デフォルトでServersタブが表示されます。これ以外の場

合は、Remote Console Switchesタブが表示されます。

Defaultがチェックされていない場合、Explorerは、チェックボックスの下に示され

るドロップダウン・リストで選択された表示内容を表示します。ドロップダウン・リス

トには、Remote Console Switches、Servers、Sites、およびFoldersの値が含まれ

ます。ドロップダウン・リストは、チェックボックスが無効の場合にのみ有効です。

スタートアップ時の指定表示方法を変更するには：

1 RCSソフトウェアのExplorerメニューから、Tools → Optionsを順に選択しま

す。Optionsダイアログ・ボックスが表示されます。

2 ドロップダウン・リストから、Remote Console Switches、Servers、Sites、また

はFoldersのいずれかを選択します。

3 OKをクリックして新しいスタートアップ・ビューを保存します。

-または-

Cancelをクリックすると、変更を保存しないで終了します。

デフォルト・ブラウザの変更

ブラウザ・ウィンドウでサーバーURLを表示する際にどのブラウザを起動するかを

指定することができます。使用システムのデフォルト・ブラウザを使用するよう選

択するか、あるいはこのサーバーで起動させる特定のブラウザを選択します。

デフォルト・ブラウザを変更するには：
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1 ExplorerメニューからTools → Optionsを順に選択します。Optionsダイアロ

グ・ボックスが表示されます。

2 Launch Default Browserチェックボックスをクリックして無効にします。Browse

ボタンが有効になります。

3 Browseボタンをクリックし、ブラウザへ移動します。

4 OKをクリックして新しいブラウザの選択を保存します。

-または-

Cancelをクリックすると、変更を保存しないで終了します。

ローカル・データベースの管理
このソフトウェアを実行している各クライアント・ワークステーションには、使用ユ

ニットに関して入力された情報を記録するローカル・データベースが含まれていま

す。複数のクライアント・ワークステーションがある場合には、一台のステーション

を設定した後に、そのデータベースのコピーを保存し、それを他のステーションに

読み込むと、各ステーションで再設定を行う手間を省くことができます。また、その

データベースをエクスポートして、別のアプリケーションで使用することもできま

す。

データベースの保存

RCSソフトウェアでは、ローカル・データベースのコピーを保存できます。保存され

たデータベースは、後に、データベースが作成された同じコンピューターに戻して

読み込むか、または別のクライアント・ワークステーションに読み込むことができま

す。保存されたデータベースは、単一のZipファイルに圧縮収納できます。

データベースの保存実行中は、これ以外のすべてのアクティビティは実行できず、

その他すべてのウィンドウを閉じる必要があります。他のウィンドウが開いている

場合にはメッセージが表示され、開いているウィンドウをすべて閉じてデータベー

スの保存を続行するか、またはデータベースの保存処理をキャンセルするかの選

択を求められます。

データベースを保存するには：
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1 RCS Explorerのメニューから、File → Database → Saveを順に選択しま

す。Database Saveダイアログ・ボックスが表示されます。

2 保存するデータベースを選択するには：

3 ファイル名を入力して、ファイルを保存する場所を参照します。

4 Saveをクリックします。保存中は進行状態を示すバーが表示されます。完了す

るとメッセージが表示され、保存が正しく実行されてメイン・ウィンドウに戻るこ

とが示されます。

データベースの読み込み

この機能により、前に保存したデータベースを読み込むことができます。すべての

アクティビティを停止し、他のすべてのウィンドウを閉じる必要があります。他のウ

ィンドウが開いている場合にはメッセージが表示され、開いているウィンドウをす

べて閉じてデータベースの読み込みを続行するか、またはデータベースの読み込

み処理をキャンセルするかの選択を求められます。

データベースを読み込むには：

1 RCS Explorerのメニューから、File → Database → Loadを順に選択しま

す。Database Loadダイアログ・ボックスが表示されます。

2 読み込むデータベースを参照して選択します。

3 Loadをクリックします。読み込み中は進行状態を示すバーが表示されます。完

了すると、読み込みが正常に終了したことを知らせるメッセージが表示され、

メイン・ウィンドウに戻ります。

データベースのエクスポート

この機能を使うと、各フィールドをローカル・データベースからASCCIIカンマ区切り

形式ファイル( CSV) またはタブ区切り形式ファイル( TSV) にエクスポートすること

ができます。エクスポートされるのは次のデータベース・フィールドです。

Remote Console Switchフラグ

種類

名前

アドレス
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サイト

部門

場所

説明

連絡先名

連絡先電話番号

コメント

ブラウザURL

Telnetポート

注: Addressフィールドは、Remote Console Switchにのみ適用され、Browser URLフ
ィールドはサーバーのみに適用されます。 エクスポートされたファイルで、サーバー
の場合は、Addressフィールド・データが空になり、Remote Console Switchの場合
は、Browser URLフィールド・データが空になります。

エクスポートされたファイルの第一行目には、フィールド・データのコラム名が表示

されます。 次行以降の各行には、Remote Console Switchまたはサーバーのフ

ィールド・データが表示されます。 このファイルには、ローカル・データベースで定

義される各Remote Console Switchおよびサーバーについての情報を有する行

が含まれています。

データベースをエクスポートするには：

1 RCS Explorerのメニューから、File → Database → Exportを順に選択しま

す。Database Exportダイアログ・ボックスが表示されます。

2 ファイル名を入力し、エクスポートされたファイルを保存する場所へ移動しま

す。

3 エクスポートする形式の種類を、Files of Typeドロップダウン・リストから選択

します。

4 Exportをクリックします。エクスポート中は進行状態を示すバーが表示されま

す。完了すると、エクスポートが正しく実行されたことを知らせるメッセージが

表示され、メイン・ウィンドウに戻ります。
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ビューアの使用法

Remote Console Switchシステム内のサーバーには、ビューアを使用して接続で

きます。このビューアから、サーバーのキーボード、モニター、マウス機能を完全

にコントロールできます。また、個々のサーバーのサムネール・ビューアでの表示

を有効にすることで、カスタマイズしたサーバー・リストを使用してスキャンするこ

ともできます。このビューアには一連のサムネール・フレームが表示され、それぞ

れのフレームに、サーバーの画面を小さくスケーリングした非対話式バージョンの

画像が表示されます。詳細については、「スキャン・モードを使用した複数サー

バーの表示」( ページ79) を参照してください。

RCSソフトウェアからのサーバーへのアクセス
RCSソフトウェアのServersタブには、データベース内で定義されているサーバー

のリストが表示されます。グループ選択ペインが表示され、データベースで定義さ

れているサーバーの固有な種類がすべてツリー表示で表示されます。グループ選

択ペインは、複数のサーバー・タイプが定義されている場合にのみ表示されま

す。All Servers、またはフォルダのどちらかをクリックして、特定タイプのすべての

サーバーを表示できます。サーバーを選択してConnect Videoタスク・ボタンをクリ

ックすると、ビューアが起動します。
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図4.1: RCSソフトウェア -Serversタブ

サーバーにアクセスするには：

1 ExplorerでServersタブをクリックします。

2 ユニット選択ペインでサーバーを選択します。

3 Connect Videoタスク・ボタンをクリックします。

-または-

サーバーを右クリックします。 ポップアップ・メニューが表示されま

す。Connect Videoを選択します。

-または-

サーバー名をダブルクリックします。

-または-

Enterキーを押します。新しいウィンドウが開いてビューアが起動します。

システム内でサーバーを検索するには：

1 Serversタブをクリックして、検索テキストボックス内にカーソルを置きます。



ビューアの使用法xxx | xxx65

2 検索情報を入力します。これは、サーバー名、あるいは別のユニット選択リス

トのヘディングであるTypeやLocationとして入力した情報でも構いません。

3 Searchボタンをクリックします。結果はユニットリストに表示されます。

4 検索の結果を参照します。

-または-

Clear Resultsボタンをクリックし、リスト全体をもう一度表示します。

閲覧中のサーバーとのインターラクション
サーバーへの接続がいったん確立されると、自分の画面にサーバーのデスクトッ

プ・ウィンドウが表示されるようになります。これは別のウィンドウとして表示され

ます。ローカルのカーソルとサーバーのカーソルの2つが表示されます。 一緒に

移動しない場合に位置合わせを行ったり、飛び跳ねるような場合にはビデオを調

整する必要がでてくる場合があります。このウィンドウから、あたかもサーバーの

前に着座しているかのように、このサーバーの通常機能全般にアクセスすること

ができます。また、特定のマクロ・コマンドをサーバーに送信するなどの、ビューア

固有のタスクも実行できます。

注: リモート・ビデオ・セッション中にマウスの反応が遅くなった場合は、対象デバイス
のオペレーティング・システムでマウスの加速をオフにし、マウスの速度を50%に設定
してください。
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ビューア・ウィンドウの機能

図4.2:ビューア・ウィンドウ

1 メニュー・バー:ビューアの機能の多くにアクセスできます。

2 アクセスしたサーバーのデスクトップ：このウィンドウからサーバーと対話しま

す。
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ビューアのメニュー・バー

図4.3:ビューアのメニュー・バー

1 画鋲： クリックするとメニュー・バーが所定の位置に固定されます。固定する

ことにより、メニュー・バーからマウス・カーソルを移動した後もメニュー・バー

が非表示になりません。

2 メニュー・オプション： メニューからビューアで利用できる機能にアクセスしま

す。

3 ツールバー・ボタン： ツール・バーには最大10個のボタンを追加できます。 こ

れらのボタンを使用すると、定義済みの機能およびキーボードのマクロに簡

単にアクセスできます。 デフォルトでは、ローカル・カーソルの位置合わせ、

画像の更新、およびシングル・カーソル・モードの各ボタンが表示されます。

4 接続ステータス・インジケーター： 接続ステータス・インジケーターに、ユー

ザーがこのサーバーのアプライアンスにどのように接続されているかが表示

されます。詳細については、「セッション共有オプション」( ページ87) を参照し

てください。

接続ステータス・インジケーター： 共有モード

エクスクルーシブ・モード

アクティブな接続( 通常、非共有、非エクスクルーシ

ブ・セッション)

表 4.1: 接続ステータス・インジケーター
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接続ステータス・インジケーター： 共有モード

能動共有( プライマリ・ユーザー)

能動共有( セカンダリ・ユーザー)

受動共有

ステルス・モード

スキャン

5 スマート・カードのステータス・インジケーター：スマート･カードの状態は、ビデ

オ・ビューアのツールバーの右端にあるスマート･カード･アイコンに表示され

ます。

アイコン 説明

スマート・カードがスマート・カード・リーダーに挿入されていないか、また

はスマート・カード・リーダーが接続されていません。

スマート・カードはスマート・カード・リーダーに入っていますが、マッピング

されていません。

スマート・カードはマッピングされています。

表 4.2: スマート・カードのステータス・インジケーター

ビューアの調整

各ユーザーの要件に合わせてビューア設定を調整できます。この調整には、画面

の解像度やツールバーの設定、キーボードのマクロ設定などが含まれます。
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ビューア・ツールバーの調整

ツール・バーには最大10個のボタンを追加できます。 これらのボタンを使用する

と、定義済みの機能およびキーボードのマクロに簡単にアクセスできます。デフォ

ルトでは、ローカル・カーソルの位置合わせ、画像の更新、およびシングル・カー

ソル・モードの各ボタンが表示されます。

ツールバーにボタンを追加するには：

1 ビューアのToolsメニューからSession Optionsを選択します。Session Options

ツールバーが表示されます。

2 Toolbarタブをクリックします。

3 ビューアのツールバーに追加する項目をクリックして選択します。

4 OKをクリックして変更内容を受け入れ、ビューアのメイン・ウィンドウに戻りま

す。

図4.4: SessionOptionsダイアログ・ボックスのToolbarタブ

ツールバーの非表示遅延時間の設定

Thumbtackボタンがクリックされていなければ、マウス・カーソルを離した後、ツー

ルバーは非表示になります。マウス・カーソルを離してからツールバーが消えるま
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での時間は、Toolbar Hide Delayの時間を調整することで変更できます。

Toolbar Hide Delayの時間を変更するには：

1 ビューアのToolsメニューからSession Optionsを選択します。Session Options

ツールバーが表示されます。

2 Toolbarタブをクリックします。

3 Toolbar Hide Delayフィールドに、マウス・カーソルを離した後にツールバーを

表示したい秒数を入力します。

-または-

上と下のボタンをクリックして、マウス・カーソルを離した後にツールバー

を表示したい秒数を増減します。

4 OKをクリックして変更した内容を受け入れ、ビューアのメイン・ウィンドウに戻

ります。

ビューアの拡大と更新

デフォルトでは、ビューアの表示を調整するための3つのボタンがビューアのツー

ルバーに表示されています。最初のボタンは、ビューアをシングル・カーソル・

モードに設定する場合に使用します。この設定により、サーバー上と同じようにビ

ューアでマウスを使用できます。ビューアがシングル・カーソル・モードに設定され

ている場合、ローカル・カーソルは表示されません。

注:シングル・カーソル・モードは、Windowsプラットフォーム上でのみ有効です。

2番目のボタンはビデオを更新するために、3番目のボタンはマウス・カーソルの

位置合わせに使用します。

図4.5:ビューアのツールバー－表示調整ボタン

ビューアをシングル・カーソル・モードに設定するには：

ビューアのツールバーで、シングル・カーソル・モードボタンをクリックします。

画面を更新するには：
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ビューアのツールバー上の画像の更新ボタンをクリックします。

-または-

ビューアのメニューから、View → Refreshを順に選択します。デジタル化されたビ

デオ・イメージは完全に再生成されます。

マウスのカーソルの位置を合わせるには：

ビューアのツーバー上のローカル・カーソルの位置合わせボタンをクリックしま

す。ローカル・カーソルの位置がリモート・サーバー上のカーソルと揃います。

フルスクリーン・モードにするには：

ビューアの右上隅の最大化ボタンをクリックします。

-または-

ビューアのメニューからView → Full Screenを選択します。デスクトップ・ウィンド

ウは表示されなくなり、アクセスされたサーバーのデスクトップだけが見えるように

なります。画面のサイズは、最高で1600 x 1200( 標準) と1680 x 1050( ワイドスク

リーン)の解像度まで変更されます。モニターのデスクトップ解像度がこれより優

れている場合は、フルスクリーンのイメージが黒の背景で縁取られます。浮動

ツールバーが表示されます。

フルスクリーン・モードを終了するには：

Escキーを押してフルスクリーン・モードを終了し、デスクトップ・ウィンドウに戻りま

す。

ビューアの解像度の調整

Auto Scaleが有効に設定されている場合、セッション中にビューアのウィンドウの

サイズが変更されるのに従い、自動的に表示が調整されます。共有を使用してチ

ャンネルにアクセスすると、そのチャンネルのプライマリ・ユーザーが選択した入

力解像度に合わせて表示が調整されます。これにより、プライマリ・ユーザーが影

響を受けずに済みます。解像度がセッション中に変更されると、表示が自動的に

調整されます。
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Full Scaleが選択されている場合、ビューアはサーバーの画面解像度に調整され、

最大1600 x 1200( 標準)および1680 x 1050( ワイドスクリーン) まで画面サイズを

拡大します。

ビューアのウィンドウのサイズを調整するには：

メニュー・バーからView → Scaling →Auto Scaleを選択して、サーバーの画像の

サイズを自動的に調整します。

-または-

メニュー・バーからView →Scaling → Full Scaleを選択します。

-または-

Scalingサブメニューから画面の解像度を選択します。

図4.6:ビューアのスケール

ビデオ画質の調整

ビューアは自動／手動のビデオ調整機能を備えています。一般に、自動ビデオ調

整を選択した場合には、調整可能な範囲で最高のビデオ画像に最適化されます。

しかしながら、特定のニーズに合わせてビデオを変更することも可能です。大きく

調整する場合は、スライダー・バーを使用します。プラス( +) とマイナス( -) のボタ
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ンを使って微調整できます。手動でのビデオ調整の詳細については、「図 4.7」を

参照してください。

色の深度の調整

注: Colorコマンドは、プライマリ・ユーザーのみが使用できます。 このコマンドはセッ
ションを共有するプライマリ以外のユーザーは使用できません。

注: Session Optionsダイアログ・ボックスでBackground Refreshが有効になっている
場合は、色の解像度が自動的にBest Color Availableにセットされ、変更はできませ
ん。

Colorサブメニューを使用すると、デジタル画像を圧縮する際の色の解像度を設定

できます。 Remote Console Switchは、Dambrackasビデオ圧縮( DVC) アルゴリズ

ムをサポートしています。このアルゴリズムにより、RCSソフトウェアのユーザー

は、リモート・セッション・ウィンドウで表示可能な色の数を調整できます。 表示色

数を増やすと最高の忠実度が得られ、色数を減らすとネットワーク上で転送される

データ量が減少します。

ビューアのウィン ドウはBest Color Available( 更新間隔が長い) 、 Best

Compression( 更新間隔が最も短い) 、またはBest ColorとBest Compressionとの

組み合わせの使用、あるいはGrayscaleで表示できます。

個々のポートとチャンネルの色の解像度は、Remote SessionウィンドウでView →

Colorの順にコマンドを選択して指定できます。この設定はポート別およびチャン

ネル別に保存されます。

色の解像度を設定するには：

ビューアのメニューからColorを選択し、Colorサブメニューから色の解像度を選択

します。

ビューアウィンドウのビデオ画質を手動で調整するには：

1 ビ ューアのメニューでTools → Manual Video Adjustを順に選択しま

す。Manual Video Adjustダイアログ・ボックスが表示されます。

2 調整する機能のアイコンをクリックします。

3 スライダー・バーを移動するか、またはマイナス( -) またはプラス( +) ボタンを

クリックすることで、押されている各アイコンに対応するパラメーターを調整し

ます。調整は直ちにビューアのウィンドウに反映されます。



74xxx |ビューアの使用法xxx

4 完了したら、CloseをクリックしてManual Video Adjustダイアログ・ボックスを閉

じます。

手動ビデオ調整ダイアログボックスのオプション

図4.7: Manual VideoAdjustダイアログ・ボックス

注: OBWIを使用してビューアを起動した場合は、上記のようなManual Video Adjust
ダイアログ・ボックスが表示されます。 RCSソフトウェアを使用してビューアを起動し
た場合は、Closeボタンの上にHelpボタンも表示されます。

1 画像キャプチャーの幅

2 ピクセル・サンプリング微調整

3 画像キャプチャーの水平位置

4 画像キャプチャーの垂直位置
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5 コントラスト

6 明るさ

7 ノイズのスレッシュホールド

8 スレッシュホールド優先順位

9 自動ビデオ調整

10 画像の更新

11 調整バー

12 ビデオ・テスト・パターン

13 Help

14 Performance Monitor

15 Closeボックス

リモート・ビデオ・セッションの変色抑制

リモート・ビデオ・セッションを設定する場合、ネットワーク状態が原因となるピクセ

ルの色落ちが発生することがあります。 この状況は、背景が純色の場合に最も多

く起こります。これは黒い背景を使用することで最小限に抑えられます。カラーの

背景を使用した場合、画面上のピクセルの少数が色落ちするか白くなります。

リモート・ビデオのピクセルの色落ちを最小限に抑えるには：

1 ビ ューアのメニューでTools → Manual Video Adjustを順に選択しま

す。Manual Video Adjustダイアログ・ボックスが表示されます。

2 コントラストまたは明るさを選択します。

3 画質が改善されるまで、コントラストと明るさを少しずつ調整します。

4 インクリメンタルな微調整には、Tools →Manual Video Adjustのノイズのスレ

ッシュホールド設定も使用できます。

注: ノイズのスレッシュホールドをゼロまで下げると、ビデオが継続的に更新され、ネ
ットワーク利用率が上がり、ビデオのちらつきが起こります。 Dellでは、ノイズのスレ
ッシュホールドを最大に設定し、移動するマウス・カーソルの下のピクセルの色が復
元される間も、システムの性能が効率よく活用されるようにすることを推奨します。
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注: ノイズのスレッシュホールドを調整する場合、大きく調整する場合はスライダー・
バーを、微調整する場合はスライダー・バーの両端のプラス( +)ボタンとマイナス( -)
ボタンを使用します。

画面の背景色表示の改善

写真画像や多色使いのグラデーション背景が選択されているターゲット・サー

バーを表示している場合、色表示が途切れることがあります。 最適な画質ならび

に性能が得られるよう、オペレーティング・システムの背景色には純色を選択する

ようお薦めしています。

マウスの調整

ビューアでは、マウス・カーソルの5つの異なるオプションを選択し、マウスのス

ケーリングを設定し、正しくトラッキングしなくなったマウスを再同期することができ

ます。Dellでは、Local CursorオプションをNoneに設定して、ローカル・カーソルを

オフにすることを推奨します。こうすると、画面上にはリモート・カーソル一つだけ

が残ることになり、操作が容易になります。

図4.8:ビューアのマウスのSessionOptionsダイアログ・ボックス
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マウス・スケーリングの設定

マウス・スケーリングの設定は、事前に設定されたマウス・スケーリング設定のオ

プション3種から選択するか、またはユーザー自身のカスタム・スケーリングを設

定することもできます。事前に設定されている3つのオプションには、Default

( 1:1) 、High ( 2:1) 、 Low (1:2) があります。1:1のスケーリング率では、デスクトッ

プ・ウィンドウでのマウスのすべての動きは、実際の動きと同等の動きとしてサー

バーに送られます。2:1 のスケーリングでは、マウスの動きは2倍速の動きとして

送られます。1:2のスケーリングでは、2分の1の速度になります。

マウス・スケーリングをカスタム設定するには：

1 ビューアのメニューでTools → Session Optionsを順に選択します。Session

Optionsダイアログ・ボックスが表示されます。

2 Mouseタブをクリックします。

3 Custom ボタンをクリックします。Xフィールド、Yフィールドが有効になります。

4 必要なマウスのスケーリング値を、XフィールドとYフィールドに入力します。マ

ウスの各入力に対し、マウスの動きは、XとYの各スケール係数を乗じた動きと

なります。有効な入力範囲は、0.25～3.00です。

マウスの軌跡の最小化

リモート・ビデオ・セッションの間、画面上をマウスが移動したとき、一部のピクセル

が色落ちした状態で残ります。この状態はマウスの軌跡と呼ばれ、ネットワーク・

レベルの変動、および異なる環境でのその他のノイズが原因で生じます。マウス

の軌跡を最小限に抑えるには、Manual Video Adjustダイアログ・ボックスのNoise

Thresholdの値を低くする必要があります。

ノイズのスレッシュホールドを下げるには：

1 ビ ューアのメニューでTools → Manual Video Adjustを順に選択しま

す。Manual Video Adjustダイアログ・ボックスが表示されます。

2 調整する機能のNoise Adjust Thresholdアイコンをクリックします。

3 マウスを使用して、スライダー・バーをスケールの中央に移動し、ゼロに下げ

ます。
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4 スライダー・バーの両端のプラス( +) ボタンとマイナス( -) ボタンを使用して、ノ

イズのスレッシュホールドをゼロの真上に微調整します。

注: ノイズのスレッシュホールドをゼロに設定すると、ビデオが継続的に更新されるた
め、ネットワーク利用率が上がり、ビデオのちらつきが起こります。 ノイズのスレッシ
ュホールドは最大に設定し、移動するマウス・カーソルの下のピクセルの色が復元さ
れる間も、システム性能を効率化することをお薦めしています。

注: ノイズのスレッシュホールドを調整する場合、大きく調整する場合はスライダー・
バーを、微調整する場合はスライダー・バーの両端のプラス( +)ボタンとマイナス( -)
ボタンを使用します。

マウスの性能の改善

マウスの応答が遅かったり、リモート・ビデオ・セッションでマウス・ポインタが同期

を外れる場合は、ターゲット・サーバーのオペレーティング・システムでマウスの加

速を無効化して対処できます。

Microsoft Windows：

1 マウスの加速をオフにします。

2 マウスの速度を、スライダー・バーの真ん中に調整します。

注:具体的な手順については、Windowsオペレーティング・システム付属のマニュア
ルを参照してください。

Red Hat Linux：

1 Desktop ControlsからMouse設定を選択します。

2 Accelerationを1.0に設定します。

3 マウスを再同期する場合は、ビューアのAlign Local Cursor/Mouseボタンを使

用します。

マウス・カーソルのちらつきの抑制

RCSソフトウェア・クライアント・マシンのビデオ・ドライバーがDirectDraw®をサ

ポートしない場合に、RCSソフトウェアのDirectDrawオプションが有効になってい

ると、画面上でマウス・カーソルのちらつきが起こります。 RCSソフトウェアの出荷

時デフォルトでは、DirectDrawは無効になっています。クライアント・システムの
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ビデオ・ドライバーがDirectDrawをサポートしており、性能を向上させたい場合、

次の手順に従ってDirectDrawを有効にします。

DirectDrawを有効または無効にするには：

1 Explorerウィンドウで、Tools →Optionsを選択します。

2 DirectDrawチェック・ボックスをクリックして有効または無効にします。

3 OKをクリックします。

4 RCSソフトウェアを再起動します。

スキャン・モードを使用した複数サーバーの表示

ビューアでは、スキャン・モードのサムネール・ビューアにより複数のサーバーを

同時に表示することができます。 これは一連のサムネール・フレームの表示で、

各フレームはサーバー画像の縮小／非インタラクティブ版になっています。各サ

ムネールの下には、ステータス・インジケーターとともにサーバー名が表示されま

す。

サーバーのスキャン

サムネールビューアにより、最高16台のサーバーのスキャン・シーケンスをセット

アップして、使用中のサーバーをモニターできます。スキャン・モードでは、サム

ネール画像が一つずつ移動します。このとき、サーバーにログインした後、( View

Time Per Serverで) ユーザーが指定した時間だけ最新のサーバー画像が表示さ

れ、その後そのサーバーからログアウトして、次のサムネール画像に移動します。

また、サムネール間のスキャン遅延を指定することもできます( Time Between

Serversを使用) 。この遅延の間は、他のサーバーにログインはしないものの、ス

キャン・シーケンスに含まれるすべてのサーバーの最後のサムネール画像が表

示されます。

各フレーム表示の下の表示ライトに、サーバーのステータスが表示されます。 サ

ムネールのデフォルト・サイズはスキャンリスト内のサーバー数によって異なりま

す。
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図4.9:ビューアでのサムネール・ビューア

スキャン・モードは、アクティブな接続よりも優先順位が低くなります。サーバーと

インタラクティブ・セッションを行っている場合、そのサーバーはスキャン・シーケン

ス内で飛ばされ、スキャン・モードは次のサーバーへ進むことになります。ログイ

ンのエラー・メッセージは表示されません。インタラクティブ・セッションが終了する

と、サムネールが再びスキャン・シーケンスに含まれます。別のユーザーがサー

バーとのアクティブな接続を確立している場合、そのサーバーはスキップされ、フ

レームの下の表示灯に赤い「X」文字が表示されます。

RCSソフトウェアは、複数のRemote Console Switchに接続されているサーバーを

スキャンできます。
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RCSソフトウェアからのスキャン・モードへのアクセス

図4.10: RCSソフトウェア -サーバーのスキャン

RCSソフトウェアでスキャン・モードにアクセスするには

1 Explorerで、Remote Console Switch、Servers、Sites、Foldersのいずれかの

タブを選択します。

2 Shiftキーを押しながら、ユニット選択ペインで2台以上のサーバーを選択しま

す。

-または-

Ctrlキーを押します。Scan Modeタスク・ボタンが現れます。

3 Scan Modeタスク・ボタンをクリックします。サムネール・ビューアウィンドウが

現れます。
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サムネール・ビューのステータス・インジケーター

緑色のLEDはサーバーが現在スキャンされていることを示します。 赤色のXはそ

のサーバーのスキャンが前回正しく行われなかったことを示します。スキャンは、

アカウント情報や無効なパス( Remote Console Switch上のサーバー・パスが使用

不可) 、あるいは他の何らかの理由により正しく実行されない場合があります。 マ

ウス・ポインタを赤いX上に合わせると、ツールのヒントが表示され、失敗の理由が

示されます。スキャン設定のセットアップ

スキャン設定を設定するには：

1 サムネール・ビューから、Options→Preferencesを順に選択しま

す。Preferencesダイアログ・ボックスが表示されます。

2 View Time Per Serverボックスに、スキャン中に各サムネールがアクティブに

なる時間( 10～60秒) を入力します。

3 Time Between Serversボックスに各サーバーの間でスキャンが停止する時

間の長さ( 5～60秒) を入力します。

4 OKをクリックします。

サムネール・ビューアの操作

個々のサムネール・フレームをハイライトしてサムネール・メニューを選択すると、

そのサーバーのインタラクティブ・セッションを立ち上げたり、そのサーバーをスキ

ャンシーケンスに追加したり、そのサーバーのログインのアカウント情報を設定し

たりすることができます。 Optionsメニューでは、スキャン設定へのアクセスに加

え、スキャンの一時停止、全サーバーのサムネール・サイズ設定などができます。

サーバーのビデオ・セッションを起動にするには：

1 サーバーのサムネールを選択します。

2 サムネール・ビューアからThumbnail → [サーバー名] →View Interactive

Sessionを順に選択します。

-または-

サーバーのサムネールを右クリックして、View Interactive Sessionを選択

します。インタラクティブなビューアのウィンドウで、サーバーのビデオが

起動します。
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スキャン・シーケンスでサーバーを有効または無効にするには：

1 サーバーのサムネールを選択します。

2 サムネール・ビューアから、Thumbnail → [サーバー名] →Enableを選択しま

す。

-または-

サーバーのサムネールを右クリックし、Enableを選択します。そのサー

バーは、サーバーのサムネールのスキャン・シーケンスに含まれるか、

除外されます。

注: Enableメニュー項目の状態は、選択するたびにチェック付き(有効)からチェック
なし(無効)に切り替わります。

注:サーバーがユーザーからアクセスされている場合、そのサーバーのサムネール
についてはEnableメニューは無効になります。

スキャン・シーケンスを一時停止または再始動するには：

サムネール・ビューアから、Options → Pause Scanを順に選択します。サムネー

ル・ビューアでスキャンが進行中の場合、スキャン・シーケンスは現在のサムネー

ルで一時停止し、スキャンが一時停止している場合はスキャン・シーケンスが再開

します。

サムネールのサイズを変更するには：

1 サムネール・ビューアから、Options→ Thumbnail Sizeを順に選択します。

2 必要なサムネールのサイズをメニューから選択します。

マクロを使用したキーストロークのサーバーへの送信

ビューアのMacrosメニューを使うと、複数のキーストロークを簡単にサーバーに送

ることができます。 ビューアには、Microsoft Windowsシステム、Sunシステ

ム、Linuxシステムで利用できるキーストローク選択項目のリストが表示されます。

どちらのシステムを使うかを選ぶには：

ビューアでMacroメニューをクリックします。Display on Menuを選択

し、Windows、Sun、Linuxのいずれかを選択します。

キーストロークをサーバーに送るには：
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ビューアのMacroメニューをクリックし、サーバーに送信するキーストロークを含む

マクロの名前を選択します。図 4.11、図 4.12および図4.13に利用できるマクロを

示します。

図4.11:ビューアのマクロ・メニュー展開表示(Windowsオプション)

図 4.12:ビューアのマクロ・メニュー展開表示(Sunオプション)
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図4.13:ビューアのマクロ・メニュー展開表示(Linuxオプション)

Session Options - Generalタブ

Session Optionsダイアログ・ボックスのGeneralタブを使用すると、フルスクリーン

以外のモー ドでの Keyboard Pass- through オプ シ ョン、 Menu Activation

Keystroke、およびBackground Refreshの選択内容を制御できます。

Keyboard Pass-throughチェック・ボックスでは、Keyboard Pass-throughモードを

有効にするかどうかを指定できます。Keyboard Pass-throughオプションは、デフ

ォルトでは選択されていません。
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図4.14: SessionOptions -Generalタブ

Menu Activation Keystrokeリスト( None、Pause、F1～F12) を使用すると、ツール

バーを起動するキーストロークを選択できます。

Background Refreshチェック・ボックスでは、背景の更新を有効にするかどうかを

指定できます。このオプションを選択した場合、デバイスで変更が生じたかにかか

わりなく、ビューアにデバイスから一定のデータの流れが送信されます。

セッション・オプションを変更するには：

1 ビューアのToolsメニューからSession Optionsを選択します。Session Options

ツールバーが表示されます。

2 Generalタブをクリックします。

3 セッションのオプションを必要に応じて変更します。

4 OKをクリックします。

スクリーン・キャプチャー

ビューアでは、画面の内容をキャプチャーし、ファイルに保存したり、クリップボー

ドにコピーしたりできます。

ファイルに画面をキャプチャーするには：
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1 ビューアで、File →Capture to Fileを順に選択します。Saveダイアログが表示

されます。

2 ファイルを保存する場所を参照します。

3 File Nameフィールドにファイル名を入力し、Saveをクリックします。

クリップボードに画面をコピーするには：

ビューアで、File →Capture to Clipboardを順に選択します。画像がクリップボード

に保存され、文書や画像編集アプリケーションに貼り付けられるようになります。

注: Capture to Clipboard機能はLinuxでは利用できません。

セッション共有オプション

注: Dell 1081ADと2161ADスイッチの場合、セッション共有をサポートするためにDell
リモート・アクセス・キー( RAK)が必要です。

セッション共有の構成を実行できるのは、管理者、およびアプライアンス管理者ま

たはユーザー管理者の管理者アクセス権を持つその他のユーザーです。 ターゲ

ット・デバイスとの最初のKVMセッションを開始したユーザーは、プライマリ・ユー

ザーと呼ばれます。 別の(セカンダリ) ユーザーがこの同じターゲット・デバイスと

のKVMセッションを開始しようとした場合、セカンダリ・ユーザーに与えられるオプ

ションは次の2つの条件により異なります。

• 2人のユーザーのアクセス権

• 管理者がグローバル接続共有を構成しているかどうか

自動共有、エクスクルーシブ接続、およびステルス接続の構成はすべて、接続の

共有が有効になっている場合にのみ可能なオプションです。

自動共有

接続の共有により、複数のユーザーが同時に共通のターゲット・デバイスと対話

することができます。プライマリ・ユーザーの場合、別のユーザーが接続の共有を

希望していることがダイアログ・ボックスによって知らされます。Yesを選択して共

有を許可するか、Noを選択して共有を拒否できます。またはPassive Shareボック
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スをクリックして、新しいユーザーにその接続への制御権を持たない共有を許可す

ることができます。

別のユーザーが表示しているデバイスでビデオ・セッションを開こうとした場合、そ

のデバイスが表示中であることが通知されます。共有設定の内容に応じて、ビデ

オ・セッションの共有またはプリエンプト操作のオプションが提供されます。また、

ステルス・ビデオ・セッションの開始オプションも提供されます。

デバイスへのアクセスは、デバイスに対する現在のユーザーの接続権限に左右さ

れます。ビデオ・セッション・ユーザーには、プライマリ・ユーザーおよび最大11の

同時接続セカンダリ・ユーザーの2種類があります。接続を共有するすべてのユー

ザーで、プリエンプト操作リクエストを許可または拒否できるのは、プライマリ・

ユーザーのみです。プライマリ・ユーザーはまた、ビデオ・パラメーターと、ビデオ・

セッションの表示解像度に対する制御権も維持します。

セカンダリ・ユーザーは、マウスおよびキーボードによるデータ入力が可能なアク

ティブなユーザーか、マウスおよびキーボードによるデータ入力が許可されてい

ない受動ユーザーのいずれかになります。

Remote Console SwitchでAutomatic Sharingが有効になっている場合、セカンダ

リ・ユーザーはプライマリ・ユーザーにセッション参加の許可を求める必要はあり

ません。

プライマリ・ユーザーがそのセッションを終了すると、アクティブなユーザー権限を

持ち、参加順が最も古いセカンダリ・ユーザーがプライマリ・ユーザーになります。

プライマリ・ユーザーがセッションを終了するときに、アクティブなユーザーの権限

を持ちセッションを共有するセカンダリ・ユーザーが存在しない場合には、そのセッ

ションは終了します。

デジタル共有モードを使用すると、複数のユーザーがターゲット・デバイスの表示

とインターラクションを実行できます。セッション共有中、セカンダリ・ユーザーは、

キーボードとマウスの制御権を持つアクティブ・ユーザー、または制御権のないパ

ッシブ・ユーザーのどちらにもなり得ます。

KVMセッションを共有できるようにスイッチを構成するには、以下の手順で行いま

す：

1 ExplorerでAppliancesボタンをクリックします。

2 次の手順のいずれかを実行します：
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• ユニット・リスト内のRemote Console Switchをダブルクリックします。

• ユニット・リストからRemote Console Switchを選択し、Manage Appliance

ボタンをクリックします。

• ユニット・リスト内のRemote Console Switchを右クリックします。ポップア

ップ・メニューから、Manage Applianceを選択します。

• ユニット・リストからRemote Console Switchを選択し、Enterキーを押しま

す。

3 Global - Sessionsのサブカテゴリーを選択します。

4 Connection Sharing領域内のEnable Share Modeを選択します。

5 Automatic Sharingを選択することもできます。共有の自動化を選択すると、セ

カンダリ・ユーザーはプライマリ・ユーザーにアクセス権をリクエストせずに、

自動的にKVMセッションを共有できるようになります。

デジタル接続の共有は以下の手順で行います：

1 ExplorerでDevicesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のターゲット・デバイスをダブルクリックします。

• ターゲット・デバイスを選択し、Connect Videoボタンをクリックします。

• ターゲット・デバイスを右クリックします。ポップアップ・メニューか

ら、Connect Videoを選択します。

• ターゲット・デバイスを選択し、Enterキーを押します。

他のユーザーがこのターゲット・デバイスを参照している場合は、この

ターゲット・デバイスがすでにKVMセッション中であることを告げるメッ

セージが表示されます。

スイッチで接続共有がオンになっており、( プライマリ・ユーザーのアクセ

ス権に対して優位な)アクセス権を持っている場合は、既存のセッションを

共有またはプリエンプトするように促すメッセージが表示されます。

1 選べる場合は、Shareを選択します。

2 次の手順のいずれかを実行します：
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• OKまたはYesをクリックします。Automatic Sharingが選択されていない場

合は、プライマリ・ユーザーに共有リクエストが送信されます。プライマリ・

ユーザーは、アクティブ・ユーザーまたはパッシブ・ユーザー(読み取り専

用) として共有リクエストを承認することも、リクエストを完全に拒否するこ

ともできます。

• Noをクリックすると共有リクエストはキャンセルされます。

プライマリ・ユーザーが共有リクエストを承認した場合、あるいはAutomatic

Sharingがオンになっている場合は、ターゲット・デバイス・セッションに対するKVM

セッションが開き、セッション・ステータスがアクティブかパッシブかを示すセッショ

ン・タイプ・アイコンが新たなビデオ・ビューア・ウィンドウ内に表示されます。 リク

エストが拒否されると、その旨を告げるメッセージが表示されます。 管理者には、

この段階でいくつかのオプションがあります。 管理者はもう一度接続してセッショ

ンのプリエンプトを試行するか、ステルス・モードで接続するか、またはセッション

を完全に終了することができます。

共有モードで接続するためのプロンプトが表示されない場合、ターゲット・デバイ

スの接続先のスイッチでデジタル共有モード・セッションを許可するよう設定されて

いないか、またはスイッチがRemote Console Switchではないかのどちらかです。

エクスクルーシブ・モード

セッションの共有とエクスクルーシブ接続が有効になっていれば、エクスクルーシ

ブのKVMセッションを確立できます。エクスクルーシブ・モード・セッションの場合、

他のユーザーからの共有リクエストは受信できません。 ただし、管理者はセッショ

ンをプリエンプト( または終了) するか、またはセッションをステルス・モードでモニ

ターするかを選択することができます。

エクスクルーシブ・モードを選択したときに他のユーザーがセッションを共有してい

る場合、エクスクルーシブ・モードの選択により他のユーザーはセッションから接

続解除されると警告を受けます。

注:エクスクルーシブ・セッションをリクエストできるのは、プライマリ・ユーザーのみ
です。 エクスクルーシブ・モードのリクエスト時に他のユーザーが共有している場
合、プライマリ・ユーザーのアクセス・レベルかどうかにかかわらず、すべてのユー
ザーが接続解除されます。



ビューアの使用法xxx | xxx91

スイッチでエクスクルーシブのKVMセッションを有効にするには、以下の手順で行

います：

1 ExplorerでAppliancesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のRemote Console Switchをダブルクリックします。

• ユニット・リストからRemote Console Switchを選択し、Manage Appliance

ボタンをクリックします。

• ユニット・リスト内のRemote Console Switchを右クリックします。ポップア

ップ・メニューから、Manage Applianceを選択します。

• ユニット・リストからRemote Console Switchを選択し、Enterキーを押しま

す。

1 Global - Sessionsのサブカテゴリーを選択します。

2 Connection Sharing領域内のEnable Sharedチェック・ボックスを選択します。

3 Connection Sharing領域内のExclusive Connectionsを選択します。

エクスクルーシブ・モードでのビデオ・ビューアにアクセスできるのは、共有接続の

プライマリ・ユーザー、もしくは非共有セッションでの唯一のユーザーのみです。

エクスクルーシブ・モード中のビデオ・ビューアへのアクセスは以下の手順で行い

ます：

1 ターゲット・デバイスに対するKVMセッションを開始します。

2 Video Viewerツールバーから、Tools → Exclusive Modeを順に選択します。

3 KVMセッションが現在共有中である場合、このセッションをエクスクルーシブ

に指定できるのはプライマリ・ユーザーのみです。 プライマリ・ユーザーは、

エクスクルーシブ・セッションのコマンドが実行されるとセカンダリ・ユーザー

のセッションは終了される旨のメッセージを受けます。

次の手順のいずれかを実行します：

• Yesを選択すると、セカンダリ・ユーザーのセッションは終了されます。



92xxx |ビューアの使用法xxx

• Noをクリックすると、エクスクルーシブ・モードの操作はキャンセルされま

す。

セカンダリ・ユーザーはエクスクルーシブのKVMセッションを共有できません。 た

だし、管理者または特定のアクセス権のあるユーザーの場合には、セッションを終

了させることができます。

ステルス接続

管理者は、ターゲット・デバイスにステルス・モードで接続し、リモート・ユーザーの

ビデオ出力を(ユーザーには分からない状態で)閲覧することができます。ステル

ス・モード中、管理者はターゲット・デバイスのキーボードやマウスを制御すること

はできません。

スイッチでステルスのKVMセッションを有効にするには、以下の手順で行います：

1 ExplorerでAppliancesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のRemote Console Switchをダブルクリックします。

• ユニット・リストからRemote Console Switchを選択し、Manage Appliance

ボタンをクリックします。

• ユニット・リスト内のRemote Console Switchを右クリックします。ポップア

ップ・メニューから、Manage Applianceを選択します。

• ユニット・リストからRemote Console Switchを選択し、Enterキーを押しま

す。

3 Global - Sessionsのサブカテゴリーを選択します。

4 Connection Sharing領域内のStealth Connectionsを選択します。

ターゲット・デバイスをステルス・モードでモニターするには、以下の手順で行いま

す：

1 ExplorerでDevicesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のターゲット・デバイスをダブルクリックします。

• ターゲット・デバイスを選択し、Connect Videoボタンをクリックします。
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• ターゲット・デバイスを右クリックします。ポップアップ・メニューか

ら、Connect Videoを選択します。

• ターゲット・デバイスを選択し、Enterキーを押します。

3 他のユーザーがすでにこのターゲット・デバイスを参照している場合は、この

ターゲット・デバイスがすでにKVMセッション中であることを告げるメッセージ

が表示されます。

スイッチで接続の共有およびステルス接続がオンになっており、アクセス

権(プライマリ・ユーザーのアクセス権に対して優位な) を持っている場合

は、現行セッションを共有またはプリエンプトするように促すメッセージが

表示されます。選べる場合は、Stealthを選択します。

4 次の手順のいずれかを実行します：

• OKまたはYesをクリックします。

• Noをクリックするとステルス接続のリクエストはキャンセルされます。

ターゲット・デバイスへのKVMセッションが開き、管理者は他に分からな

い状態で、ターゲット・デバイスのビデオ出力をすべて参照できるように

なります。

ステルス接続がオプション中に表示されない場合には、下記のいずれかを意味し

ます：

• ターゲット・デバイスの接続先のスイッチでStealth Connectionsがオンになっ

ていない

• 必要なアクセス権がない(プリエンプト権限の次にステルス権限が位置してい

ます)

• ターゲット・デバイスの接続先のスイッチがRemote Console Switchではない

プリエンプト・モード

プリエンプトは、有効な権限を持つユーザーが、同等またはそれ以下の権限を持

つ別のユーザーに対してサーバーを管理する方法です。

注:プリエンプト操作中の接続を共有するすべてのユーザーが警告を受けますが、(
有効になっている場合)プリエンプト操作を拒否できるのはプライマリ・ユーザーの
みです。
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表4-3に、プリエンプト操作のシナリオおよびプリエンプト操作リクエストを拒否す

るシナリオの詳細を示しています。プリエンプト操作とバーチャル・メディア・セッシ

ョンの予約およびロックの詳細については、「セッション共有オプション」( ペー

ジ87) を参照してください。

現在のユーザー プリエンプト操作リクエスト元
プリエンプト操作リクエス

ト拒否、可／不可

リモート・ユーザー ローカル・ユーザー 不可

リモート・ユーザー リモート管理者 不可

リモート・ユーザー Remote Console Switch管理者 不可

Remote Console Switch
管理者

ローカル・ユーザー 可

Remote Console Switch
管理者

Remote Console Switch管理者 可

リモート管理者 ローカル・ユーザー 不可

リモート管理者 リモート管理者 可

リモート管理者 Remote Console Switch管理者 不可

ローカル・ユーザー リモート管理者 可

ローカル・ユーザー Remote Console Switch管理者 可

表 4.3: プリエンプト操作のシナリオ

リモート管理者によるリモート・ユーザーのプリエンプト操作

リモート管理者が、リモート・ユーザーによってアクセスされているサーバーへア

クセスを試みた場合、プリエンプトされることがユーザーに通知されるまでの間待

機するように管理者に求めるメッセージが表示されます。 リモート・ユーザーはこ

のプリエンプト・リクエストを拒否できないため、接続解除されます。接続解除まで
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の時間は、Sessionダイアログ・ボックスのビデオ・セッションのプリエンプト操作タ

イムアウト設定で定義します。

注:表示中のサーバーがアボセント製スイッチに接続されている場合は、その期間
は表示されません。

ローカル・ユーザー／リモート管理者のリモート管理者によるプリエンプト操作

管理者が、同等の権限を持つローカル・ユーザーまたは別のリモート管理者によ

ってアクセスされているサーバーへアクセスを試みた場合、現在接続している

ユーザーはプリエンプト操作リクエストを許可または拒否することができます。 接

続しているローカル・ユーザーまたはリモート管理者に、プリエンプト操作リクエス

トを受け入れるかどうかを尋ねるメッセージが表示されます。プリエンプト操作リク

エストが拒否された場合、リモート管理者にリクエストの拒否およびサーバーへの

アクセス不可を伝えるメッセージが表示されます。

注:表示中のサーバーがアボセント製スイッチに接続されている場合、ユーザーは
プリエンプト操作の許可または拒否を選択することができません。

注: プリエンプト操作リクエストが拒否されるシナリオでは、Session Preemption
Requestダイアログ・ボックスが表示されます。 このダイアログで、Acceptボタンをク
リックしてプリエンプト操作リクエストを許可したり、Rejectボタンをクリックするまたは
ダイアログ・ボックスを終了して、プリエンプト操作リクエストを拒否することができま
す。

現行のユーザーをプリエンプトする場合は以下の手順で行います：

1 ExplorerでDevicesボタンをクリックします。

2 次の手順のいずれかを実行します：

• ユニット・リスト内のターゲット・デバイスをダブルクリックします。

• ターゲット・デバイスを選択し、Connect Videoボタンをクリックします。

• ターゲット・デバイスを右クリックします。ポップアップ・メニューか

ら、Connect Videoを選択します。

• ターゲット・デバイスを選択し、Enterキーを押します。

他のユーザーがこのターゲット・デバイスを参照している場合は、この

ターゲット・デバイスがすでにKVMセッション中であることを告げるメッ

セージが表示されます。
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このスイッチで接続共有がオンになっている場合は、セッションを共有す

るかどうかを選択できます。接続共有の詳細については、「プリエンプト・

モード」を参照してください。 アクセス権( プライマリ・ユーザーのアクセス

権に対して優位な) を持っている場合は、現行セッションを共有またはプリ

エンプトするように促すメッセージが表示されます。

3 選べる場合は、Preemptを選択します。

4 次の手順のいずれかを実行します：

• OKまたはYesをクリックします。プライマリ・ユーザーにプリエンプト通知

が送られます。アクセス権がプライマリ・ユーザーより下位の場合、プライ

マリ・ユーザーはプリエンプト操作を拒否できることがあります。

• Noをクリックすると、プライマリ・ユーザーの接続は維持されます。

5 プリエンプト操作が完了すると、ターゲット・デバイス・セッションのビデオ・ビ

ューアが開きます。

バーチャル・メディア
バーチャル・メディア・サポートにより、USBメディア・デバイスをアプライアンス

のUSBポートに直接接続することができ、アプライアンスに接続されているどの

ターゲット・デバイスでも使用できます。バーチャル・メディアには、リモートからも

アクセスできます。 リモート・メディア・セッションでは、クライアント・コンピュー

ターに直接取り付けたデバイスを使用します。

バーチャル・メディア機能により、あらゆるサーバーとの間でバーチャル・メディア

のデータを表示、移動、コピーすることができます。オペレーティング・システムの

インストール、オペレーティング・システムの回復、ハード・ドライブの回復や複

製、BIOSの更新、サーバーのバックアップが可能になり、リモート・システムを効

率よく管理できます。

KVMセッションを行うユーザーは、ターゲット・デバイスにマップされたどのメディ

ア・デバイスにもアクセスできます。不正アクセスなどのセキュリティ・リスクを回

避するため、バーチャル・メディア・セッションをKVMセッションにロックすることが

できます。
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バーチャル・メディア・デバイスのメディアを変更する場合は、まず、バーチャル・メ

ディア・デバイスのマッピングを解除してください。 それから新しいメディアを挿入

し、バーチャル・メディア・デバイスを再マッピングします。これで、このメディアを

新しいバーチャル・メディア・セッションで利用することができます。

バーチャル・メディア・サポートの要件を次に示します。

• DVD-ROMドライブ( 1台) と大容量記憶装置( 1台)は同時にマッピングできま

す。

• CD/DVD-ROMドライブまたはISOディスク・イメージ・ファイルはバー

チャルのDVDドライブとしてマッピングされます。

• ディスク・ドライブ、ディスク・イメージ・ファイル、USBメモリー・デバイ

ス、その他のメディア・タイプはバーチャルの大容量記憶装置として

マッピングされます。

• 所定のサーバーでバーチャル・メディアを使用するには、Dell USB2 SIP、Dell

USB2+CAC SIP、Avocent MPUIQ- VMC、DSAVIQ- PS2M、またはDSAVIQ-

USB2のモジュールを用いて、そのサーバーをKVMに接続する必要がありま

す。

• パッシブ拡張モジュールに接続されているサーバーに対してバーチャル・メデ

ィア・セッションを開始することはできません。

• バーチャルにマッピングしようとしているUSB2対応メディアのタイプが、ター

ゲット・デバイスでサポートされている必要があります。 すなわち、ターゲッ

ト・デバイスでポータブルUSB 2.0メモリー・デバイスがサポートされていない

場合には、ローカル・デバイスをバーチャル・メディア・ドライブとしてターゲッ

ト・デバイスにマッピングすることはできません。

• ユーザー( またはユーザーが所属するユーザー・グループ)には、バーチャ

ル・メディア・セッションまたはターゲット・デバイスに対する専用バーチャル・

メディア・セッションを確立する権限が必要です。

• 1082DSは、同時に3つまでのバーチャル・メディア・セッション( ローカル、リ

モートを含む)をサポートしています。 2162DSは、同時に4つまでのバーチャ

ル・メディア・セッション( ローカル、リモートを含む) をサポートしています。

4322DSは、同時に6つまでのバーチャル・メディア・セッション( ローカル、リ
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モートを含む) をサポートしています。 ターゲット・デバイスに対するバーチャ

ル・メディア・セッションは、一度に1つのセッションのみ実行可能です。

共有およびプリエンプト操作

KVMセッションとバーチャル・メディア・セッションは別個のものです。従って、共

有／専用／プリエンプト・セッションには多くのオプションがあります。

例えば、KVMセッションとバーチャル・メディア・セッションは、一緒にロックするこ

とが可能です。このモードでは、KVMセッションの接続が解除されると、関連付け

られているバーチャル・メディア・セッションの接続も解除されます。これらのセッ

ションが一緒にロックされていない場合は、KVMセッションは終了しますが、バー

チャル・メディア・セッションはアクティブのままになります。

関連するアクティブなKVMセッションがないにもかかわらず、バーチャル・メディ

ア・セッションがターゲット・デバイスでアクティブになっている場合には、このチャ

ンネルへのオリジナル・ユーザー( ユーザーA) による再接続、または、別のユー

ザー(ユーザーB)による接続が可能です。 ユーザーAのみがKVMセッションに関

連付けられたターゲット・デバイスにアクセスできるよう設定することもできます。

このオプション( Reserved) はバーチャル・メディア・ウィンドウ内にあります。

ユーザーBがこのKVMセッションにアクセスしている場合( Reservedのオプション

がオンになっていない) 、このユーザーはバーチャル・メディア・セッションで使用さ

れているメディアを制御することが可能です。これは、一部の環境においては望

ましくない場合があります。

ティアド接続環境でReservedオプションを使用すると、ユーザーAのみが下層アプ

ライアンスにアクセス可能で、上層アプライアンスと下層アプライアンス間のKVM

チャンネルがユーザーA専用となります。

プリエンプト・レベルにより、この他にも設定に柔軟性を持たせることができま

す。「プリエンプト・モード」( ページ93) を参照してください。

バーチャル・メディアの起動

ビューアを使用して、バーチャル・メディアをアプライアンスからリモートで起動しま

す。ビューアは、OBWIまたはRCSソフトウェアから起動できます。 バーチャル・メ

ディア・クライアントでは、ユーザーがローカル・ドライブをターゲット・サーバーの

バーチャル・ドライブにマッピングすることができます。
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RCSソフトウェアからバーチャル・メディアを起動するには：

1 ソフトウェアからビューアを起動します。詳細については、「ビューアの使用

法」( ページ63) を参照してください。

2 Tools →Virtual Mediaを順に選択します。

3 このセッションを予約に指定したい場合は、「バーチャル・メディア」ウィンドウ

でDetailsをクリックした後、Reservedチェックボックスをオンにします。

ターゲット・サーバーには、フロッピー／フラッシュ・ドライブとCD/DVDドライブの2

種類のデバイスをマッピングできます。バーチャル・メディア・クライアントでは、そ

れぞれ1つを同時にマッピングできます。また、バーチャル・メディア・クライアント

では、フロッピーのイメージ・ファイル( *.img) やCDのイメージ・ファイル( *.iso) を

バーチャル・デバイスにマッピングすることも可能です。

バーチャル・メディア・インターフェイスは、フロッピー・ドライブ、CD／DVDドライ

ブ、ステータスという3つの区分で構成されています。バーチャル・メディア・セッシ

ョンがKVMセッションにロックされると、バーチャル・メディア・クライアント画面の

右上にロック状態を示すアイコンが表示されます。

バーチャル・メディア・ドライブのマッピング

バーチャル・メディア・ドライブをマッピングするには：

1 ビデオ・ビューアのツールバーからTools →Virtual Mediaを選択してバーチャ

ル・メディア・セッションを開始します。

2 物理ドライブをバーチャル・メディア・ドライブとしてマッピングするには、以下

の手順で行います：

a. バーチャル・メディア・ウィンドウで、マッピングしたいドライブの横

のMappedチェック・ボックスをオンにします。

b. マッピングするドライブを読み取り専用アクセスに制限したい場合は、ドラ

イブのマッピングを開始する前にRead Onlyチェック・ボックスを選択して

おきます。マッピングされたドライブすべてが読み取り専用に既に設定さ

れている場合は、このチェック・ボックスにはチェック印が付いており、こ

れを変更することはできません。
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セッションが読み取り／書き込み可能に設定されていて、特定の

ドライブへのアクセスを読み取り専用に制限したい場合に

は、Read Onlyチェック・ボックスを選択して設定を変更すること

ができます。

3 ISOまたはディスク・イメージをバーチャル・メディア・ドライブとして追加／マッ

ピングするには、以下の手順で行います：

a. バーチャル・メディア・ウィンドウで、Add Image をクリックします。

b. Common File Chooserウィンドウが開き、ディスク・イメージ・ファイル( .iso

または.imgの拡張子)を含むディレクトリが表示されます。ISOまたはディ

スク・イメージ・ファイルを選び、Openをクリックします。

c. 確認のため、ファイル・ヘッダにはチェック印がつきます。チェック印がつ

いていればCommon File Chooser ウィンドウは閉じられ、選択したイメー

ジ・ファイルがバーチャル・メディア・ウィンドウ内に開きます。マップ済み

チェック・ボックスを選択すると、このウィンドウからイメージ・ファイルをマ

ッピングできます。

d. 他にもISOやフディスク・イメージを追加したい場合は、手順a～cを繰り返

します。イメージ・ファイルは( メモリーの容量範囲内で)いくつでも追加で

きますが、バーチャルのDVD-ROMまたは大容量記憶装置は同時に1つ

しかマッピングできません。

多過ぎる数のドライブ( DVDドライブ1つと大容量記憶装置1つ) 、

あるいは多過ぎる特定タイプ・ドライブ( 1つのDVDドライブまた

は大容量記憶装置より多く) をマッピングしようとすると、メッセー

ジが表示されます。 さらに新しいドライブをマッピングしたい場

合には、まず現在マッピングされているドライブのマッピングを

解除してから、別のドライブをマッピングしてください。物理ドライ

ブまたはイメージをマッピングすると、ターゲット・デバイスで使

用できるようになります。

バーチャル・メディア・ドライブのマッピングを解除するに：

マッピングされたドライブをターゲット・デバイスから取り外します。 Mappedチェッ

ク・ボックスの選択を解除します。
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バーチャル・メディアの接続ステータス

ステータスの区分には、バーチャル・メディアの接続に関する情報が表示されま

す。 現在確立されている接続がない場合は、各欄に「No connection」また

は「n/a」と表示されます。

バーチャル・メディア・ドライブの状態を表示するには、以下の手順で行います：

1 バーチャル・メディア・ウィンドウで、Detailsをクリックします。ウィンドウが拡

張され、Details表が表示されます。各行の情報は、次のとおりです：

• Target Drive －ターゲット・サーバーに接続されているバーチャル・デバ

イス

• Connected To － バーチャル・デバイスに接続されているローカル・ドラ

イブの名前

• Read Bytes－ターゲット・サーバーがローカル・デバイスから読み取った

バイト数

• Write Bytes － ターゲット・サーバーがローカル・デバイスに書き込んだ

バイト数

• Duration －ドライブをマッピングしてから経過した時間。

2 Detailsビューを閉じるには、Detailsを再度クリックします。

バーチャル・メディア・セッション

バーチャル・メディア・セッションは、2つのUSB接続が単一ケーブルを介して確立

されるときに開始されます。 これらの接続は、コンピューター上でUSB CD／DVD

ドライブまたはUSB大容量記憶装置として認識されます。 バーチャル・メディア・セ

ッションの設定には、ロック状態、マップされたドライブへのアクセス、暗号化レベ

ルがあります。

• Locked －特定のKVMセッションに関連付けられたバーチャル・メディア・セッ

ション。KVMセッションを終了すると、バーチャル・メディア・セッションが終了し

ます(例えば、KVMセッションがプリエンプトされた場合、ユーザーによって閉

じられた場合、またはスクリーン・セーバーが起動して停止した場合、関連付

けられたバーチャル・メディア・セッションがアプライアンスによって自動的に
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終了します) 。ただし、ロック状態のバーチャル・メディア・セッションを終了して

も、対応するKVMセッションは終了しません。

• Mapped drive access － このアクセス・モードは読み取り専用に設定できま

す。アクセス・モードが読み取り専用の場合、クライアント・コンピューター上

のマップされたドライブにはデータの書き込みはできません。アクセス・モード

が読み取り専用になっていなければ、マップされたドライブに対する読み取り

と書き込みが可能になります。マップされるドライブが設計上読み取り専用(

特定のCDドライブやDVDドライブ、ISOイメージなど)の場合には、読み取り／

書き込みの両方可能に設定されていても無視されます。読み取り専用に設定

しておくと、大容量記憶装置や外付けUSBメディアのような読み取り／書き込

み対応ドライブをマップした後に、誤って上書きされることを回避できます。

• Encryption level －バーチャル・メディア・セッションでは、最大3つの暗号化

レベ ルを構成できます。どの組み合わせでも有効です。選択肢に

は、AES、DES、3DES、および128ビットRC4( ARCFOUR) SSL暗号化がありま

す。設定されている最も高位のレベルが使用されます。デフォルト設定では暗

号化は設定されていません(暗号化レベルが選択されていません) 。

バーチャル・メディア・セッションの予約

バーチャル・メディア・セッションを予約して、指定したユーザー名または管理者の

みがセッションにアクセスしたり、セッションを終了したりするようにできます。 KVM

セッションを閉じた後もバーチャル・メディア・セッションを続行したい場合は、バー

チャル・メディア・セッションを予約できます。予約したバーチャル・メディア・セッシ

ョンは、関連付けられたKVMセッションが閉じてもアクティブに維持されます。

バーチャル・メディア・セッションを予約するには：

バーチャル・メディア・ウィンドウで、Detailsをクリックし、Reserveチェック・ボックス

を選択します。

USBバスのリセット

USBリセット機能は、ターゲット・デバイス上のすべてのUSBメディア( マウスおよ

びキーボードを含む)をリセットします。 この操作を実行するのはターゲット・デバ

イスが応答しない場合のみに限定してください。

USBバスをリセットするには：

1 バーチャル・メディア・ウィンドウで、Detailsをクリックします。
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2 USB Resetを選択します。

バーチャル・メディア・セッションの終了

バーチャル・メディア・ドライブを終了するには以下の手順で行います：

1 ExitまたはXをクリックし、ウィンドウを閉じます。

2 マップしたドライブがある場合は、マップが解除される旨のメッセージが表示さ

れます。マップを解除するにはYesをクリックしてウィンドウを閉じ、マップの解

除をキャンセルするにはNo をクリックしてウィンドウを閉じます。

ロック状態のバーチャル・メディア・セッションに関連付けられているアクティブ

なKVMセッションを接続解除しようとすると、バーチャル・メディアのマッピングが

終了になることを告げる確認メッセージが表示されます。

バーチャル・メディアとUSB2の制限

Remote Console Switchのバーチャル・メディア機能により、接続されているデバ

イスのUSBポートへの接続が可能になります。この機能を使用することにより、ス

イッチの場所にいるまたはRCSソフトウェアを使用しているユーザーは、接続され

ているコンピューターからUSBのCD／DVD-ROMドライブ、ディスク・ドライブまた

はFLASHドライブなどのローカルUSBストレージ・デバイスにアクセスすることがで

きます。

USB2 SIPは、キーボード、マウス、DVDドライブ、大容量記憶装置の4つの機能に

対応する複合デバイスです。CD／DVDドライブと大容量記憶装置が、バーチャ

ル・メディア・セッションがマップされているかどうかに関係なく、ターゲット・デバイ

スに表示されます。メディア・デバイスがマップされていない場合は、メディアなし

の状態で表示されます。バーチャル・メディアがターゲット・デバイスにマップされ

ていると、メディアが挿入されたことがターゲット・デバイスに通知されます。メディ

ア・デバイスのマップが解除されると、メディアが取り外されたことがターゲット・デ

バイスに通知されます。このため、USB2バーチャル・デバイスは、ターゲット・デバ

イスから接続解除されません。

USB2 SIPケーブルは、キーボードとマウスを複合USB2 デバイスとして表示しま

す。このため、BIOSで複合USB 2.0ヒューマン・インターフェイス・デバイス( HID)

をサポートしている必要があります。接続されたコンピューターのBIOSがこの種

のデバイスをサポートしない場合は、オペレーティング・システムにUSB 2.0デバイ
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ス・ドライバーが読み込まれるまで、キーボードとマウスが作動しない可能性があ

ります。この場合、USB 2.0接続のキーボードとマウスに対するBIOSサポートを含

むBIOSアップデートがコンピューター・メーカーから提供されていることがありま

す。

バーチャル・メディアを使用したコンピューターの起動

多くの場合、このバーチャル・メディアの機能によって、接続されているコンピュー

ターをスイッチのUSBポートに取り付けられているデバイスから起動することがで

きます。 USBポートを有する大部分のコンピューターではバーチャル・メディアを

使用できますが、USBメディア・デバイスおよびシステムBIOSの一部に見られる制

限により、Remote Console Switchに取り付けられているUSBデバイスからコンピ

ューターを起動することができない場合があります。

バーチャルUSBデバイスからの起動は、ターゲット・デバイスが外付けの複合USB

デバイスからの起動をサポートするかどうかによって決まります。 また、外付

けUSB2.0による起動をサポートするオペレーティング・システムのCD／DVDが必

要です。以下は、外付けUSB2.0デバイスによる起動をサポートするオペレーティ

ング・システムの一部の一覧です：

• Windows Server 2003

• Windows XP

• Windows 2000 Server( Server Service Pack( SP4) 以降)

使用コンピューターでバーチャル・メディアから起動ができるかどうかを判定する

には、以下の手順に従ってください。

1 起動可能な状態になっているオペレーティング・システムのインストー

ルCD／DVDを挿入したUSB CD／DVD-ROMドライブをRemote Console

Switchに接続して、それをターゲット・デバイスにマッピングします。 ターゲッ

ト・デバイスを再起動して、取り付けたCD／DVDドライブから起動するかどう

かを指定します。外付けUSBデバイスから起動するには、BIOSを設定する必

要がある場合があります。

2 ターゲット・デバイスが起動しない場合は、ターゲット・デバイスのUSBポート

にUSBCD／DVDドライブを接続して、ターゲット・デバイスを再起動します。

ターゲット・デバイスがCD／DVDドライブから正常に起動する場合は、そ
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のBIOSは複合USB 2.0デバイスからの起動をサポートしていません。 ターゲ

ット・デバイスのメーカーのサポートWebサイトを閲覧して、複合USB 2.0デバ

イスからの起動をサポートする最新版のBIOSが利用できるかどうかを判断し

てください。利用できる場合は、BIOSを更新して、手順をもう一度行います。

3 ターゲット・デバイスが外付けUSB 2.0デバイスから起動できない場合は、以

下の方法を使用してそのターゲット・デバイスをリモートで起動します。

• BIOSバージョンの一部では、USB速度を制限するオプションが提供されて

います。このオプションが利用可能な場合は、USBポートの設定を「USB

1.1」または「Full Speed」モードに変更してもう一度起動してみてください。

• USB 1.1カードを挿入してもう一度起動してみてください。

• USB 1.1ハブをUSB2ケーブルとターゲット・デバイスの間に挿入して、もう

一度起動してみてください。

• 複合USB 2.0デバイスからの起動をサポートするBIOSバージョンを現在

利用できるか、または更新の予定があるかどうかの情報を、ターゲット・

デバイスのメーカーに問い合わせてください。
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付録 A: RCSソフトウェアの更新

システムを最適な状態で運用していただくため、RCSソフトウェアの最新版をDell

サポートWebサイト( dell.com/support) で入手されていることをご確認ください。

RCSソフトウェアを更新するには：

1 DellサポートWebサイト dell.com/support から、アップデート・ファイルをダウ

ンロードします。

2 インストーラをダブルクリックします。インストーラが、ご使用のシステムに以

前のバージョンのRCSソフトウェアがインストールされているかどうかをチェッ

クします。

3 前のバージョンが検出されず、更新を確認するダイアログ・ボックスが表示さ

れた場合は、Continueをクリックします。

-または-

前のバージョンが検出され、その製品の別のバージョンがあることを警告

するダイアログ・ボックスが表示された場合は、Overwriteをクリックして、

アップグレードすることを確認します。

-または-

Cancelをクリックすると、ソフトウェアをアップグレードしないで終了しま

す。

4 インストールが開始します。プログラム・ファイル、ショートカット、環境変数、

レジストリ・エントリ( Win32システムのみ)がインストールされるか、現バージョ

ンの新しいファイルと設定で上書きされます。
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注:アップグレード検出プロセスが正しく機能するようにするためには、最初に再起動
まはたログアウトを実行する必要があります。 インストーラにより設定されるレジスト
リ・キーは、システムからログアウトするかシステムを再起動するまで、Win32プラッ
トフォームまたはLinux上で永続的に設定されたことにはなりません。
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付録 B: キーボードとマウス

操作 説明

F6キー
分割画面間で操作し、最後にフォーカスがあったアイテムへフォーカ

スを戻す。

F8キー フォーカスをディバイダーに向ける。

左向き／ 上 向

き矢印キー
フォーカスがディバイダーにある場合、ディバイダーを左に移動する。

右向き／ 下 向

き矢印キー
フォーカスがディバイダーにある場合、ディバイダーを右に移動する。

Homeキー
フォーカスがディバイダーにある場合、分割画面の右側ペインが領域

全体にわたって表示される( 左側ペインは表示されない) 。

Endキー
フォーカスがディバイダーにある場合、分割画面の左側ペインが領域

全体にわたって表示される( 右側ペインは表示されない) 。

クリック＋マウス

ドラッグ
ディバイダーを右または左に移動する。

表B.1:分割画面でのキーボードとマウスのショートカット
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操作 説明

マウスのシング

ルクリック

既存の選択を解除し、マウスポインターが位置するノードを選択す

る。

マウスのダブルク

リック

拡張可能なノード ( 子を持つノード ) の拡張／縮小ステータスをトグル

で切り替える。 リーフノード ( 子を持たないノード ) 上では機能しない。

上向き矢印

キー

既存の選択を解除し、それまで選択されていた項目のすぐ上のノード

を選択する。

下向き矢印

キー

既存の選択を解除し、それまで選択されていた項目のすぐ下にある

ノードを選択する。

スペースキー 現在の選択項目を交互に選択／選択解除する。

Enterキー
現在の選択項目を交互に縮小／拡大する。 子を持つノードにのみ

適用する。 リーフノード ( 子を持たないノード ) 上では機能しない。

Homeキー 既存の選択を解除し、ルートノードを選択する。

Endキー 既存の選択を解除し、ツリー表示の最後のノードを選択する。

表B.2:ツリー表示コントロール・キーボードとマウスのショートカット

操作 説明

Enterキーまたは

Returnキー
選択されたユニットのデフォルト動作を起動する。

上向き矢印

キー
現在の選択を解除し、一行上を選択する。

下向き矢印

キー
現在の選択を解除し、一行下を選択する。

Page Upキー
現在の選択を解除し、一頁上へスクロールしてその頁の最初のアイ

テムを選択する。

表B.3:ユニット・リストでのキーボードとマウス操作
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操作 説明

Page Downキー
現在の選択を解除し、一頁下へスクロールしてその頁の最後のアイ

テムを選択する。

Deleteキー
削除機能を実行する。 Edit-Deleteメニュー機能と同じ働きをする。

詳しい情報についていは、当該セクションを参照。

Ctrl＋Homeキー 表の最初の行にフォーカスを移動し、これを選択する。

Ctrl＋Endキー 表の最後の行にフォーカスを移動し、これを選択する。

Shift＋ 上 向 き

矢印キー
選択領域を一つ上の行まで拡大する。

Shift＋ 下 向 き

矢印キー
選択領域を一つ下の行まで拡大する。

Shift＋Page Up
キー

選択領域を前のページまで拡大する。

Shift＋Page
Downキー

選択領域を次のページまで拡大する。

Shift＋マウス・ク

リック

マウスをクリックした時点で既存の選択をすべて解除し、現在のフォー

カスポイントとマウスのポインターがある行の間の行範囲を選択する。

Ctrl＋マウス・ ク

リック

マウス・ポインターが位置する行の選択状態を、他の行の選択状態

に影響を与えることなく、トグルで切り替える。

マウスのダブルク

リック
選択されたユニットのデフォルト動作を起動する。
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付録 C: TCPポート

次の表は、Remote Console Switchによって実行される機能と、使用されるポート

の一覧です。

ポート 機能

TCP 80/443 デフォルトのHTTP/HTTPSです。

TCP 2068
ビデオ・ビューア・ビデオ、キーボード、マウス、ユーザー認証、バーチャ

ル・メディアに使用されます。

TCP/UDP 3211 管理とインストール／検出に使用されます。

表C.1:使用されるポート

注: TCP/IPポートは固定されており、変更できません。

注:ポート2068と3211のデータはすべて、Secure Socket Layer( SSL) プロトコルを使
用して暗号化されています。

注: 1081ADと2161ADスイッチの場合は、TCP 2068およびTCP/UDP 3211ポートをサ
ポートするためにRAKが必要です。
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付録 D: テクニカル・サポート

Dell製品のインストールや操作について問題や疑問点が生じた場合には当社のテ

クニカル・サポートまでご連絡ください。担当スタッフがお手伝いいたします。万一

問題が生じた場合は、より良いサービスをお受けいただけるよう、次の手順に従

ってください。

問題を解決するには：

1 問題の該当箇所をマニュアルで調べ、記載されている手順に従って解決でき

るかどうかを試してください。

2 弊社のWebサイト( dell.com/support) にある「Knowledge Base( ノレッジ・ベー

ス) 」のデータベースからご検索いただくか、あるいは「Online Service

Request( オンライン・サービス・リクエスト) 」をご利用ください。

3 最寄りのDellテクニカル・サポートまでお電話にてご連絡ください。
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